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Praise for Learning Blender

“Oliver Villar’s book will give you a solid foundation in Blender and computer graphics 
in general. Filled with well-crafted examples and lessons, this book will give you the 
tools you need to succeed as an artist.”

—David Andrade, Producer, Theory Studios

“The days are now over when beginners found learning Blender 3D difficult. Oliver 
 Villar introduces to beginners the best of Blender’s 3D features and 3D fundamentals in 
fun and exciting ways. His approach of completing a character from scratch, touching 
every aspect of 3D from Blender’s point of view, is truly filled with explanations of 
techniques and important tools that will help readers to bring their ideas to life cre-
atively while following professional workf lows in 3D.

Starting with the fundamentals of 3D, this is a great resource for every beginner  
artist who is looking to learn Blender 3D. It’s truly a book written with great 
dedication!”

—Waqas Abdul Majeed, CG Generalist, www.waqasmajeed.com

“I found Oliver Villar’s book Learning Blender to be an essential tool for not only getting 
users acquainted with Blender, but also preparing them by explaining the history and 
the magic that has made Blender what it is now. His book also prepares users to be pro-
ductive and informed by explaining the community and its various portals. His book is 
complete in explaining all the aspects of the UI and acquainting users with the classic 
G, S, and R. The exercises are perfect for getting users on the level to begin making 
their own worlds. I was even pleased to see him discussing F2, ripping with V, and even 
Knife Project, which are classics I usually consider to be more advanced. This book is a 
no-holds-barred approach to getting the most out of this capable little program. I must 
also add that the character created is attractive and well created, and is a fine example 
of using the program for character modeling. Oliver is truly a skilled artist and that 
shines through in his use of this program.”

—Jerry Perkins, 3D Conceptor, Fenix Fire

http://www.waqasmajeed.com
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✥

To Grandma. I'll keep working to make you proud.

✥
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xxv

Preface

Character creation is a big undertaking. It involves several very different skills, and that’s 
what you’re going to learn soon enough. In this preface, I quickly show you what this 
book is about and what you can expect from it. If you already have some experience 
with other 3D software, you’ve come to the right place, as you’ll find some instructions 
on how to handle switching between different programs, which can be frustrating—and 
sometimes even more difficult than learning a program for the first time.

Welcome to Learning Blender!
Welcome to the third edition of Learning Blender: A Hands-On Guide to Creating 3D 
Animated Characters. In this book, you’ll learn how to use Blender in a complete and 
complex project. You’ll see every part of the process so that you can understand what 
is involved in the creation of a 3D character and decide which part you like the most 
afterward. In other words, this book is not a specialized book that will make you a 
modeling genius or an expert animator; instead, it helps you understand the basic 
concepts behind every part of the process. The idea is that when you finish reading this 
book, you’ll have the knowledge you need to start any other project, from preproduc-
tion to the final result.

If you’re a freelancer (or want to be), this book is tailored to you, as freelancers often 
get small but very different and varied jobs, and having basic or medium skills in differ-
ent tasks can be more useful than being very good at a single specific thing.

If you want to work for a big company and prefer to specialize, it helps to under-
stand the full process. If you’re a modeler, for example, but you also understand how 
rigging works, when you create your models, you’ll be able to recognize the possible 
issues that your rigger mates will encounter, which will make their work easier. When 
you work on a team, you’ll work on only part of the project, but if you have at least a 
little understanding of what the rest of the team’s job is, your work will be more valu-
able to them, and everyone will be happier!

Maybe you’re already familiar with Blender and want to learn about 3D character 
creation. Very good. You can skip the first two or three chapters and go straight to the 
main part of the book—but do this only if you’re sure that you understand the basics 
of Blender.

Finally, if you just want to get started in this amazing world of 3D and dive into 
the sea of vertices, this book will give you a good insight into how 3D projects are 
handled. If you have never used 3D software before, don’t worry if it looks a bit 
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overwhelming in the beginning. That’s normal. The software has lots of options and 
crazy stuff that will be unknown to you, and we all tend to be afraid of what we don’t 
know. If you keep going, however, when you start using and understanding Blender, 
you’ll start enjoying the learning process, and your results will get better with time and 
practice. Good luck!

Do You Come from Other 3D Software?
I took this path myself years ago, so I understand what you will go through. That’s why 
throughout the chapters, I share tips, keeping in mind the differences between Blender 
and other 3D software. I came to Blender after using commercial software such as 3ds 
Max, Maya, and XSI for years. Back then (version 2.47), Blender was less user-friendly, 
but it’s been greatly improved since then. It’s still a little alien compared with other 
software, though, and it may feel intimidating to you at first. Don’t worry; that reac-
tion is completely understandable. Just don’t give up!

Learning Blender may not be easy at first. It took me three or four times checking 
different versions of Blender until I finally decided to start learning it for good. You’ll 
see weird features, such as the omnipresent 3D cursor, which you always see in the 
scene but apparently has no function. (I’ve heard someone say that it looks like a snip-
er’s visor for shooting at your models.)

Also, you’ll be “forced” to learn a lot of shortcuts. This requirement makes the 
learning curve for Blender difficult in the beginning, but when you get used to 
Blender, you’ll love it, as shortcuts help you work a lot faster in the long run!

Before I used Blender, it was difficult for me to work with fewer than three 3D 
views on the screen at the same time, for example. Now I work in full-screen mode 
with only one view in a much more comfortable way; it’s like using the expert mode in 
other software all the time! I even feel weird sometimes when I need two 3D views for 
some special reason.

I’ve taught a lot of people and talked with many others who came to Blender from 
other software, and usually, they kind of hate it at first. (That’s why most people give 
up and stick with commercial software.) After a short time using it, though, they start 
loving Blender and get addicted to it. They find that a lot of tasks are easier or faster 
to do in Blender than in other software. It’s so common to love Blender after that 
first rejection stage, however, that there’s a name for this feeling in the community: 
Blenderitis.

Blender has its limitations, of course, but for the general needs of most users, it’s 
more than enough.

I really encourage you to keep exploring Blender and find out what it has to offer. 
I’ve learned to use a lot of different software and tools, and after repeating the learning 
process and switching software several times, I’ve found that Blender works best for me.

I’ll share the method I’ve used with you. Maybe it’ll help you too. The key to mak-
ing a successful change (not only in software, but also in life, work, or whatever you 
want) is to learn how to adapt and be f lexible. You have to free your mind to some extent 
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to leave space for the new situation, software, or anything else to get in. In these situa-
tions, a lot of people can only complain (“This software doesn’t have that tool,” “That 
was easier on the old one,” and so on). Avoid this behavior at all cost, and try to under-
stand the new software, as each program has different philosophies behind its development 
and workf low. Complaining is a waste of energy and time that you could be spending 
on something much more useful, such as learning how to use the new software.

What is the best way to adapt? Force yourself !
Set a deadline (that way, you’ll have a good or bad result, but at least you’ll finish 

something), and decide what you’re going to do. Think of an easy project, and go for 
it. Having a deadline keeps you from drifting around for days, going crazy over small 
details that make the process too long.

Usually, people start playing around with no purpose. They don’t get a specific 
result, but something random. This result doesn’t motivate them and gives them the 
impression that they can’t use the software.

Instead, if you propose a little project, you’ll have a goal to work toward, which 
allows you to find the tools you need to achieve that goal. When you finish, even if the 
project is not perfect, you’ll have learned some tools and achieved a result, which will 
motivate you to do better next time or to start a different project so you can learn about 
other tools.

Keep in mind that you probably don’t want to start with a very big or difficult proj-
ect. The key is to start learning little by little, taking small steps to keep yourself moti-
vated. If you start with something big that involves a lot of steps, you may get stuck at 
some point, which will frustrate you. When you work on something small, even if it 
goes wrong, you won’t have spent too much time after all, so getting attached to the 
project won’t be a real issue.

Over time, after you make a few small projects, you’ll have a knowledge base, and 
you’ll understand how the new software works. At that point, you can judge whether 
you’re interested in learning more or whether you’re more comfortable with the previ-
ous software.

A lot of software is out there, and each program is different, so depending on your 
work, style, taste, and personality, you may prefer one or another. What is intuitive and 
comfortable for some people isn’t for others. Nonetheless, if you give the new software 
a good test drive, even if some things that you’re used to are missing, you’ll learn about 
others that are really cool that you didn’t see before!

In my case, I was very comfortable with 3ds Max, but after using Blender exten-
sively for a few days (yes, only a few days; they were very intense days, though!), I hon-
estly couldn’t go back. I missed some tools, of course, but I found that the advantages 
clearly surpassed the disadvantages for me, so I’ve used Blender ever since.

I hope that this book motivates you to try Blender and give it a chance instead of 
deciding that you don’t like it because you can’t master it in five minutes. (I’ll bet you 
didn’t understand any other software in five minutes the first time you used it!)
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The essence of practicing to learn is to set a feasible goal, set a deadline (due date), 
and try your best to reach that goal. No excuses; no complaints! Discipline and not 
giving up are the keys.

My method is just a guideline. It may not be useful for you, or you may find a better 
approach. But if you don’t know where to start and feel discouraged, just try it!

How to Use This Book
This book is divided into parts to help you to keep track of your progress:

 ■ Part I, “The Basics of Blender” (Chapters 1, 2, and 3): Understanding 
Blender and learning the basics

 ■ Part II, “Beginning a Project” (Chapters 4 and 5): Preproduction, project 
preparation, and character design

 ■ Part III, “Modeling in Blender” (Chapters 6 and 7): Starting production, 
focusing on character modeling

 ■ Part IV, “Unwrapping, Painting, and Shading” (Chapters 8, 9, and 10): 
Unwrapping, texturing, and applying materials

 ■ Part V, “Bringing Your Character to Life” (Chapters 11 and 12): Rigging 
and animation

 ■ Part VI, “Getting the Final Result” (Chapters 13 and 14): Postproduction, 
camera tracking, rendering, and compositing

 ■ Part VII, “Keep Learning” (Chapter 15): Other Blender features

You can start with the part you’re most interested in, of course, but if you’re new to 
Blender, I recommended that you start from the beginning so that you understand the 
software before you jump into something as complex as the creation of a 3D character.

In each chapter, if some basic knowledge is required, I explain it before you dive 
into the real thing. You’ll also find tips and useful shortcuts along the way to help you 
work faster and more efficiently.

If you’re already familiar with Blender, you can skip the first three chapters and start 
reading about character creation.

Chapter 1, “What You Need to Know About Blender,” talks about Blender, open-
source software, how the development process works, its history, and what Blender is 
all about. You don’t really need to know these things to use Blender, but it’s interesting 
and gives you an overview of some of the strong points of Blender.

Chapter 2, “Blender Basics: The User Interface,” takes you through the user inter-
face, basic navigation, selections, and Blender’s innovative nonoverlapping window 
system for dividing and merging the interface as you see fit.

In Chapter 3, “Your First Scene in Blender,” you learn how to create your first scene 
with Blender. This very basic scene lets you play with the main tools, as well as work 
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with simple modeling, materials, and lighting, and it helps you understand the differ-
ences between rendering with Blender Render and rendering with Cycles.

After this introduction, you start on the main project: creating a 3D character. The 
reason you create a character as a project for this book is that it involves almost every 
part of the software: modeling, texturing, rigging, animation, and so on.

This part of the book explains everything you’ll go through, talking about prepro-
duction and how to get ready for any project. You’ll learn that preparation is essential!

In the final chapters, you see how to track the camera of a real video and composite 
your character into that scene so that you end up with something cool you can show your 
friends, not just a character inside Blender.

I discuss some other features of Blender in Chapter 15, “Other Blender Features,” so 
that you get a glance at them, including dynamic simulations, particles, smoke and fire, 
the Grease Pencil, and add-ons.

I encourage you to create your own stuff from scratch and use your own video to 
track the camera, but if you prefer to follow the book in detail (with the same material 
used in it) or want to skip some parts, you’ll find all the material you need to start from 
any point of the book in the production files (at www.blendtuts.com/learning-blender-
files), which include

 ■ .blend files with different levels of progress so you can start with whatever part of 
the book interests you. You don’t have to start from scratch.

 ■ Texture images for the character.
 ■ Real video for camera tracking.
 ■ Final results.
 ■ Video tutorials of some parts of the book.

What’s New in This Edition

What you have in your hands is the third edition of Learning Blender. The whole book 
has been updated to be compliant with Blender version 2.83 and beyond. Blender 2.83 
is the first LTS (long-term support) version of Blender, which means that it will be 
usable and errors will be fixed for at least two years after its release, making it a good 
version to start with. (General Blender versions have very short life spans, with new 
releases every three to four months.) Most figures have been updated or reworked to 
improve readability and to ref lect the changes in the new Blender versions. The whole 
character-creation process has been redone to make sure that the instructions are com-
patible with Blender 2.83. New tools are discussed throughout the book, especially (but 
not limited to) selection and modeling tools. In Version 2.80, a new real-time render 
engine was added to Blender (EEVEE), and the book shows you how to use it as well. 
A lot of new tips and tricks have been added, and some chapters have been extended 
or changed in approach, based on feedback I got from previous editions. That said, 

http://www.blendtuts.com/learning-blender-files
http://www.blendtuts.com/learning-blender-files
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I hope that you find these new additions interesting and that they improve your experi-
ence with the book and with Blender.

Without any more hesitation, get ready to start learning. You have a long way to go!

Register your copy of Learning Blender, Third Edition, on the InformIT site for 
convenient access to updates and/or corrections as they become available. To 
start the registration process, go to informit.com/register and log in or create an 
account. Enter the product ISBN (9780136411758) and click Submit. Look on the 
Registered Products tab for an Access Bonus Content link next to this product, 
and follow that link to access any available bonus materials. If you would like to 
be notified of exclusive offers on new editions and updates, please check the box 
to receive email from us.

http://informit.com/register
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3
Your First Scene in Blender

You’ve been introduced to the basics of Blender, and with practice, you’ll have the 
interface under control. It’s time to create objects; interact with them; add modifi-
ers, materials, and lights; and then render your creation. This chapter presents a very 
simple exercise to help you better understand how to create your first scene. You also 
learn about Blender Render and Cycles, the two render engines included by default in 
Blender. If you’re using Blender for the first time, you’ll find this chapter to be espe-
cially useful. The idea is that after reading this chapter, you have a basic understanding 
of the workf low to create a scene in 3D and export it as an image.

Creating Objects
When you open Blender, you’ll find the familiar default cube sitting in the middle of 
the scene. You can use that cube to build your model, or you can delete it. To delete 
objects in Blender, just select them, press X or Del, and click Delete in the dialog box 
that appears to confirm the deletion. (If you press Del instead of X, you won’t be asked 
to confirm.)

To start, you want to create an object. There are different ways to do it:

 ■ Choosing an option from the Add menu in the 3D Viewport’s header.
 ■ Pressing Shift+A in the 3D Viewport. (The Add menu from the previous option 

will appear at your mouse cursor position.)
 ■ Pressing F3 to display the Search menu, and typing the name of the object you 

want to create. The menu will filter the options/tools that include what you’ve 
entered. If you type cube, for example, the menu will show the option Add 
Cube; click that option, and the cube will be created.

When you use any of these options, the object is created in the position of the 3D 
cursor inside the 3D scene.

After you create an object, the Adjust Last Operation menu in the bottom-left 
corner of the 3D Viewport will show the options available to control that object. If you 
create a cylinder, for example, you’ll be able to control its parameters later, such as size 
and number of sides.
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Adjust Last Operation Menu
After you perform any action that can be adjusted afterward, the Adjust Last Operation 

menu will show up in the bottom-left corner of the 3D Viewport. The menu can be col-

lapsed or expanded by clicking its title (which will show the name of the last action).

Inside the menu, you’ll find all options available to tweak the last operation. For exam-

ple, if you move an object, you will be able to modify the final position in X, Y, and Z; 

adjust the orientation; and enable or disable proportional editing. Make sure to look at 

these options after using tools and options, as sometimes, you may discover interest-

ing possibilities you didn’t know about before.

If you don’t like having this menu enabled all the time, you can hide it from the View 

menu on the 3D Viewport’s header by clicking the option Adjust Last Operation.

Whether the menu is enabled or disabled, you can always call it on a pop-up that will 

appear at your mouse cursor’s position when you press F9. Some people prefer hiding 

the menu and use it (by pressing F9) only when they need it. 

Make sure that you have adjusted anything before your next action. For example, if 

you move an object after creating it, the Adjust Last Operation menu will present the 

options for the Move tool instead of the options for object creation. You can’t go back 

to a previous operation to recover this menu; you’d have to undo (Ctrl+Z) and perform 

that action again.

Animation software often has a test object. In Blender, that object is the monkey head 
(called Suzanne), and you’ll use it for the test scene in this chapter. Create a monkey 
head mesh, using any of the methods described earlier in this section. Then create a 
plane, as this plane later will serve as the f loor of your scene. Don’t worry if the head 
and plane intersect in the middle of the world and are not correctly aligned; you’ll 
adjust them in the next step.

Moving, Rotating, and Scaling
After you create objects in your 3D scene, you need to be able to control where they 
are located, how they are oriented, and what size they are. In this section, you see how 
to do just that. Moving, rotating, and scaling are the three different transform opera-
tions you can perform on any 3D object, and there are several ways to do it.

Using Active Tools
The most obvious way to transform an object is to use Active Tools: the buttons with 
icons that are shown on the 3D Viewport’s toolbar (you can show or hide this bar 
pressing T), as shown in Figure 3.1.
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Figure 3.1 Active Tools to move, rotate, and scale objects, 
located on the 3D Viewport’s toolbar

It’s simple: you choose the Move, Rotate, or Scale tools, and they become the Active 
Tools. The manipulators for the selected type of transform will be always shown for the 
current selection, and you can click and drag parts of those manipulators to perform 
the transformation. (For more information about using manipulators, see the next 
section.)

There is a fourth Active Tool for transforms, conveniently named Transform, as it 
shows manipulators for moving, rotating, and scaling simultaneously.

Although this method for transforming objects can be obvious to new users, it’s not 
always the most efficient method. Sometimes, you may prefer that your Active Tool be 
a different one, and you have to switch back and forth.

It’s convenient when you have the objects in your scene and all you need to do is to 
place them. The purpose of Active Tools, after all, is to stay active so you can use them 
repeatedly, but if you’re using different tools often, Active Tools may not be your best 
option.

Tip
You can access the toolbar while it’s hidden in a pop-up menu by pressing Shift+Space and 

clicking the desired Active Tool within the menu. In this menu, you’ll also see each tool’s 

keyboard shortcut. If you press that shortcut when that menu (Shift+Space) is shown, you’ll 

set that tool as the Active Tool. But if you press the same shortcut without the Active Tool 

menu showing, you’ll launch the normal tool, which is not persistent and will stop working 

after you perform the action.

Essentially, if you want to move many objects in a row, you can use the Active Tool by 

pressing Shift+Space and then G; this action will enable the Move tool as the Active Tool 

(the same as clicking the Move Active Tool on the 3D Viewport’s toolbar). If you only want 

to move the current selection and keep doing other actions, you can just press G to use 

the Move tool, which will be disabled when the action is accepted. Read the next sections 

for more information about transforming objects by using keyboard shortcuts.
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Using Manipulators
There is an option to show manipulators for transforms while using other Active Tools. 
All you have to do is enable them on the Viewport Gizmos pop-up within the 3D 
Viewport’s header. (See Figure 3.2.)

Figure 3.2 Manipulators in the Viewport Gizmos menu on the 3D 
Viewport’s header and different manipulations

When you want to transform objects or elements in the 3D scene, Blender offers manipu-
lators that help you control those transformations. The following are the manipulators:

 ■ Move (A): Changes the position of an object in space
 ■ Rotate (B): Controls the orientation of an object
 ■ Scale (C): Manipulates the size of an object
 ■ All Transforms (D): Allows you to use more than one transform manipulator 

at the same time

In the 3D Viewport’s header, you can select the type of transform you want to 
perform. If you press Shift while clicking different transform icons, you can perform 
 multiple transforms at the same time. (In Figure 3.2, example D shows all three trans-
form manipulators being used at the same time.)
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Using the manipulators, you can move, rotate, and scale objects. These manipulators 
appear at the pivot point of the object (marked as a little orange spot called the origin in 
Blender), and you perform an action with them by using the following controls:

 ■ Left-click one of the axes to make the object move, rotate, or resize on that 
specific axis. (X is red, Y is green, and Z is blue.) Left-click again to confirm the 
transform. Or press Enter to confirm or Esc to cancel.

 ■ To enable Precision Mode, press and hold Shift after you click to transform. This 
action makes the transform slower, allowing you to make precise adjustments.

 ■ To lock one axis and manipulate the other two, press and hold Shift before 
you click the axis you want to lock. If you press Shift and then click the Z-axis 
to move it, for example, the object actually moves on the X- and Y-axes, as 
the Z-axis is locked. (This option works only for moving and scaling; it is not 
available for rotations.) On top of using keyboard shortcuts, you can use the little 
squares present in the Move and Scale manipulators. You’ll see that, for example, 
there’s a green square between the X- and Z-axes, and it’s green because it locks 
the Y-axis (green).

 ■ Move and Scale manipulators have a small white circle in their centers. Click and 
drag the circle of the Move manipulator to move the object, using the current 
point of view as a reference (dragging it parallel to the view). Click and drag the 
small white circle of the Scale manipulator to scale the object on every axis.

The Rotation manipulator also has an outer white circle but is slightly different; 
click and drag that circle to rotate the object, using the current point of view as 
the rotation axis. Instead of having a small white circle in its center, the manip-
ulator for rotations has a spherical shape in transparent gray, and its axes are 
drawn on the surface of that sphere. Click and drag anywhere within the Rota-
tion manipulator’s sphere (without clicking any of its axes) to enter Orbit Mode, 
which allows you to rotate on all axes at the same time.

 ■ Hold down Ctrl while using these manipulators to switch between normal 
transforms and Snap Mode. This feature allows you to snap to several elements 
while you perform transforms. If snapping is enabled, holding down Ctrl frees 
the object when transforming; if it’s disabled, holding down Ctrl enables the 
snapping. This feature is very useful because you won’t need to continuously turn 
the Snap tool on and off by clicking the Snap icon on the 3D Viewport’s header. 
You’ll learn more about snapping tools later in the book.

 ■ In the 3D Viewport’s header, you can select Pivot Point and Transform Ori-
entation. Pivot Point defines the point around which objects rotate and scale. 
By default, Transform Orientation (access this menu by pressing Alt+Space) is 
global, which means that it’s aligned to the 3D World axes (default scene axes: 
X is left/right, Y is front/back, and Z is top/bottom). You can switch Transform 
Orientation to the local axes of the selection to transform objects using their own 
orientation.
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Tip
If you don’t like the default behavior of transforms in Blender (click once to start transform-

ing, and click a second time to confirm), you can activate the Release Confirms option on 

the Input tab of User Preferences. Release Confirms makes the transform behavior faster 

so that you can click and drag, and the transform is confirmed as you release the mouse 

button. This behavior is typical in other software.

Using Keyboard Shortcuts (Advanced)
Although you can use manipulators easily, the expert, really fast way to transform 
objects in Blender is to use keyboard shortcuts. Sometimes, the manipulators are useful, 
but most of the time and especially for simple transforms, using the keyboard is faster 
and more efficient (even though it requires a bit of getting used to and memorizing the 
keyboard shortcuts). Here are some of the most relevant keyboard shortcuts that make 
transforms easier and faster:

 ■ Press G (Grab) to move, R to rotate, and S to scale. When you do these things to 
move and rotate the objects, they move and rotate according to the view. Left-
click or press Enter to confirm, and right-click or press Esc to cancel.

 ■ After pressing G, R, or S, if you press X, Y, or Z, the selection transforms only 
on that global axis. Press X, Y, or Z twice to align to the selection’s local axis.

 ■ Press R twice to enter Trackball Rotation Mode, which makes the object rotate 
in all axes simultaneously following your mouse movements.

 ■ As an alternative to the previous option, when you’re transforming with no attach-
ment to a given axis, you can press MMB. Lines for the axes appear, and if you move 
the object close to one of those lines, it is automatically locked to that specific axis.

 ■ The options for precise transforms, snapping, and axis locking using Shift and 
Ctrl while transforming with manipulators also apply when you use keyboard 
shortcuts. Press G and then Shift+Z to translate the object in the X- and Y-axes 
at the same time, for example.

Numerically Precise Transforms
When you’re performing a transform, Blender allows you to input numerical values. 

If you look at the 3D Viewport’s header when you are rotating an object, you’ll find 

that the header buttons disappear and are replaced by a display of the values of the 

transform in action. At this point, you can enter values directly from your keyboard, and 

Blender will use them for the current transformation. Here are two examples:

 ■ To move an object 35 units on the X-axis, use manipulators and write the desired 

numerical value while dragging. Press G to move; then press X to snap the 

object’s movement to the X-axis. Now you can drag the object through the X-axis. 

Type 35 on your keyboard, and the object moves 35 units on the X-axis. Left-click 

or press Enter to confirm the operation.

 ■ Press R to rotate, press Y to snap to the Y-axis, and enter -90 on your keyboard 

to rotate an object -90 degrees on the Y-axis. (When you’re entering a numerical 
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value for a transform, you can add the negative value by pressing the minus key 

at any time, before or after the number. If you press the minus key again, the 

value becomes positive.) Left-click or press Enter to confirm the operation.

Not only that, you can even enter mathematical expressions to save you time if you 

start by writing an equal sign (which makes Blender understand that you’re writing an 

expression instead of just a number). For example, you can press R, Z, and then write 

=360/12 to rotate an object a fraction of a whole circle in the Z-axis without having to 

calculate it on your mind or spending time opening the calculator for complex operations. 

When you do this, the information in the header will not only display the expression 

you’re writing, but also show the resulting transform. In the case of the previous exam-

ple, the header would show this: Rot:[360/12] = 30º along global Z.

As you can see, using this method makes transformations really fast and easy to per-

form. The shortcuts are intuitive, and you can use them in most editors; G, R, and S 

always move, rotate, and scale, for example.

Using Menus
You can also use numerical fields in menus to transform objects. You’ll find such fields 
in two places of the interface (see Figure 3.3):

 ■ 3D Viewport’s Sidebar (press N to show and hide). Within the Sidebar, pick 
the Item tab, and you’ll find the Transform panel, where you can see numeri-
cal fields for every location, rotation, and scale axes.

 ■ In the Object tab of the Properties Editor, you will also find the Transform panel.

Figure 3.3 On the left side, you can see the Item tab of the 3D Viewport’s Sidebar. 
On the right side, you can see the Object tab of the Properties Editor. 

Both Transform panels can be used to input values to transform objects.
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In any of those panels, you can do either of the following things:

■ Click and type a specific number in the input field.
■ Click the arrows on the sides of the input field to increase or decrease the number.
■ Click and slide left and right to increase or decrease the number. Hold Shift while 

sliding to change the number with more precision. Hold Ctrl while sliding to change 
in increments. Hold Shift+Ctrl while sliding to change in smaller increments.

■ If you change a value in one of those parameters, the change will affect only the 
active selection. Hold Alt while you change a value to affect the entire selection; 
this command essentially expands the changes from the active selection to the 
rest of the selected objects where applicable. Click and drag up and down to select 
several adjacent fields (works only when those fields are grouped together) and 
then release to write a number that will be entered simultaneously in all of those 
fields, or drag left and right to use the sliding options in all of the selected fields 
at the same time. For example, if you wanted to scale an object in all axes, you 
could click and drag from the X scale field toward the Z scale field, release, 
type 2 on your keyboard, and press Enter to input the value of 2 in the X, Y, 
and Z scale axes in a single action.

Arranging Objects in Your Scene
Now that you know how to transform objects, you can make your f loor bigger and sit 
the monkey head on it (see Figure 3.4), as follows:

 1. Right-click to select the plane, press S to scale, enter 5 on your keyboard to make 
the plane 5 times bigger, and press Enter to confirm. (Or use the manipulators if 
you feel more comfortable with them.)

 2. Select the monkey head, moving and rotating it until it looks as though it’s sitting 
on the f loor. As a recommendation, you can switch the 3D Viewport to a side 
view to see what’s going on more clearly and transform the head there by press-
ing G and R. Keep in mind that if you’re in a side view and rotate using R, the 
object will rotate on the X-axis.

Figure 3.4 The scene before and after the transforms have been performed
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Keep in mind that you can do the same thing using any of the methods for trans-
forming objects shown in the previous section, even though throughout the book, I’ll 
use keyboard shortcuts in the explanations to help you use and memorize them.

Naming Objects and Using Datablocks
Before proceeding, you need to learn how to rename objects. This skill will come 
in handy when you’re working in complex scenes and want to recognize objects by 
their names. Otherwise, you’ll find yourself lost in a sea of objects called Plane.001, 
Sphere.028, and similar generic names.

If a Blender scene were a wall made of bricks, each brick would be a datablock. 
Every object in Blender has a datablock inside that represents its contents: meshes, 
materials, textures, lights, curves, and so on. Datablocks can be named and used in the 
ways discussed in the following section.

Renaming Objects
You have several ways of renaming an object:

 ■ Locate the object in the Outliner. Right-click its name and choose ID Data, 
Rename within the contextual menu. Alternatively, you can double-click the 
name, type the new name, and press Enter to confirm.

 ■ Press F2 anywhere in the interface, and a pop-up with the name text field will 
show up. Press Ctrl+F2 to open the menu for bulk renaming when you have 
multiple objects selected.

 ■ In the Properties Editor, go to the Object tab (the one with a yellow cube); type 
the new name in the text field in the top-left corner; and press Enter to confirm.

Managing Datablocks

Datablocks are the most basic Blender components. All the elements you can build—
such as objects, meshes, lamps, textures, materials, and armatures (skeletons)—are made 
of datablocks. Everything in the 3D scene is contained in an object.

Whether you’re creating a mesh, a lamp, or a curve, you’re creating an object. In 
Blender, any object has object data inside it, so the object itself acts as a kind of con-
tainer for the data and stores information about its location, rotation, scaling, modifiers, 
and so on. Object data defines what’s inside an object. If the object data is a mesh, for 
example, you see a mesh with its vertices and faces inside the object. When you access 
the object data, you can adjust its parameters. If you click the drop-down list of the object 
data datablock, you can load a different object data into the object. You could load a 
different mesh into the object’s position, for example. Several objects can use the same 
object data. (These objects are called instances or linked duplicates.) This means that even if 
the objects are in different positions in the scene, all of them synchronize their contents, 
so if you manipulate the mesh vertices in one of them, the others ref lect those changes.
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Figure 3.5 shows the difference between the Object and Object Data tabs and how 
to look for an object’s name inside the Properties Editor. The image to the right shows 
that the mesh’s name is inside the object’s name. In the image, the object data is a mesh; 
if it were a lamp or a curve, the icon would change accordingly. The Properties Editor 
always shows information about the selected object, but if you click the Pin icon, 
the selected object’s information is pinned, and even if you select a different object, the 
Properties Editor keeps displaying the pinned object’s information.

Figure 3.5 Left: Object Properties tab. Right: Object Data Properties tab. You’ll find 
both tabs in the Properties Editor, and in the image, you can see where the names for 
objects and object data can be found. You can also see how the title of the Properties 

Editor shows a hierarchy: Object’s Name > Object Data’s Name, which also serves as an 
indication of how the object data is contained in the object. The Object and Object Data 
tabs have been isolated in the image for clarification; you will find those tabs within the 

rest of the tabs of the Properties Editor.

Duplicates and Instances (Linked Duplicates)
You need to understand the difference between a duplicate and an instance. A dupli-
cate is a new object created from an existing one so that it looks the same as the 

original but is independent, and no link exists between the new one and the original. 

An instance (or as Blender calls it, linked duplicate) is also a new object; it can be in 

a different position, but its content (object data) is directly linked to the original, so if 

you change the object data in an object, the change also affects all its instances.

When you duplicate an object (Shift+D), some Object Data is duplicated with it, and 

other object data is instanced. You can define the default behavior on the Editing 

tab of User Preferences. If you duplicate an object, for example, by default Blender 

duplicates the mesh data contained in it, but it uses the same material data, so both 

objects use the same material datablock.

On the other hand, instancing (Alt+D) duplicates only the object; the rest of the object 

data it carries inside is linked and synchronized with the original object. An alternative 

way to instance a mesh (or any other datablock) is to go to the Properties Editor’s 

object data tab and select a different mesh from the drop-down list in its datablock.
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To the right of some datablock names, you find a button with a Shield icon as well 
as a number. The number indicates the number of users that the datablock has. In Fig-
ure 3.5, the mesh datablock has two users, which means that two different objects are 
using that mesh data (they’re instances). If you want to turn an instance into an indepen-
dent, unique datablock, just click the number. Blender creates a duplicate and indicates 
a single user for the new one.

Blender purges all datablocks with zero users when the file is closed to not accu-
mulate unnecessary data, so if you’re not careful, you can lose that great material you 
created but weren’t using. That’s why the Shield button next to datablocks exists; it 
creates a fake user of that datablock. Even if you’re not using the datablock in the scene, 
that datablock will have a [fake] user, which prevents the datablock from being deleted 
when you quit Blender. Datablocks that have zero users are called orphan data.

Caution
If you want to make sure that you keep a datablock in the file when you quit Blender, 

even if it’s not being used (such as a material), click the Shield button next to the data-

block’s name to make Blender know that you want to keep that datablock.

Keep in mind that you usually work with the names of objects. Most of the time, 
you don’t need to access the names of object data like meshes inside objects, so if you 
are running low on time, you can generally skip object data naming.

Naming Your Scene’s Objects
After you understand what datablocks are and how to rename objects, you can name 
the objects in your scene accordingly. (You might name the plane Floor, for example.) 
Sometimes, you have to select a datablock’s name from a list, so naming objects and 
datablocks intuitively will help you find the one you’re looking for.

Tip
When you have lots of objects in a scene, it can be difficult to select a specific one, as 

others may be in the way. If you click the objects in the 3D Viewport several times, the 

selection jumps between the objects behind the mouse cursor, and if you press Alt+LMB, 

Blender displays a list of objects behind the mouse cursor, so you can select the one you 

need. This feature is useful only when your objects are named intuitively, of course.

Using Interaction Modes
Blender provides different ways to modify objects in your scene (such as modeling, 
texturing, sculpting, and posing), called interaction modes. By default, when you work in 
Object Mode, you are able to move, rotate, and scale; Object Mode essentially allows 
you to place objects in a scene. Probably one of the most useful modes is Edit Mode, 
which you use to edit object data. For example, you would use Edit Mode to model a 
mesh; access its vertices, edges, and faces; and change its shape.
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You can find the Interaction Mode menu on the 3D Viewport’s header (see Fig-
ure 3.4); the options it displays depend on the type of object you have selected. For 
now, I focus on the Object and Edit modes. You’ll learn about the other modes 
throughout the rest of the book.

You use Object Mode to create and place things in your scene (even animate them if 
you aren’t using armatures, which are Blender skeletons used to animate characters and 
deform objects). In Edit Mode, you can perform modeling tasks on the mesh. You can 
quickly switch between these modes without having to access the selector by pressing 
the Tab key on your keyboard.

When you select an armature, you use Edit Mode to access the bones inside it and 
manipulate them. Pose Mode is available as well; it’s the mode you’ll use when ani-
mating a skeleton. (For more information, see Chapter 11, “Character Rigging,” and 
Chapter 12, “Animating Your Character.”) If you select a mesh, you have access to 
modes such as Sculpt, Texture Paint, and Vertex Paint, as shown in Figure 3.6.

Figure 3.6 The Interaction Mode selector. On the left are the 
options available when a mesh object is selected; on the right are 

the options available when an armature is selected.

You can also press Ctrl+Tab to launch a pie menu with the available interaction 
modes for the selected object.

Warning
If you come from previous versions of Blender, or you experience some issues while select-

ing objects that are in different interaction modes (for example, a mesh object and an 

armature in Pose Mode), there is a new option that you can try to disable/enable to change 

the behavior of selections between different types of objects that may have different 

interaction modes. This option is called Lock Object Modes, which you will find under Edit 

in Blender’s main menu.

As you can see, a lot of options are available, and depending on what you want to do 
at any point in time, you just have to select the right interaction mode for the actions 
you want to perform.
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Applying Flat or Smooth Surfaces
The monkey head looks weird with the rough edges and polygons that currently compose 
its shape. This look is useful for some things, but for objects that should look more organic, 
you may prefer to have a smooth surface. This option changes the surface’s appearance but 
doesn’t add any geometry. You have several ways to make a surface look smooth in Blender:

 ■ Select the object you want to smooth. Press RMB and choose the Shade Smooth 
option from the contextual menu (choose Shade Flat for the opposite result).

 ■ Select the object. Click the Object menu of the 3D Viewport’s header and select 
the Shade Smooth option.

 ■ In Edit Mode, select the faces you want to shade with the smooth or f lat method, 
press RMB, and select Shade Smooth or Shade Flat from the contextual menu. 
Alternatively, you’ll also find those options within the Face menu in the 3D 
Viewport’s header.

Figure 3.7 shows where these options are in Blender’s interface.

Figure 3.7 A comparison of flat and smooth surfaces and the menus in which you can 
find these options. On the left, you can see the Object menu from the 3D Viewport’s 

header. On the right, you can see the object’s right-click contextual menu.
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Working with Modifiers
Even though you used smooth shading in the mesh, the object still doesn’t look just 
right, as it has very low polygonal resolution. You could use a Subdivision Surface 
modifier to add more detail to the surface and smooth it out (at the cost of adding more 
polygons to the object). A modifier is an element you can add to an object to alter it, 
such as a deformation, the generation of geometry, or the reduction of existing geom-
etry. Modifiers won’t affect the original mesh and adapt automatically to the changes 
you perform in the original mesh, which gives you a lot of f lexibility, and you can turn 
modifiers on and off when you want. You should be careful, though, as adding too 
many modifiers may cause your Blender scene to operate slowly.

Adding Modifiers
Clicking the wrench icon in the Properties Editor opens the Modifiers tab, where you 
can add modifiers (see Figure 3.8). When you click the Add Modifier button, a pop-up 
menu displays every modifier you can add to the active object. (Not all the modifiers 
are available for every type of object.) The modifiers are listed in columns based on 
their functions: Modify, Generate, Deform, or Simulate. Left-click a modifier in the 
list to add it to the active object.

Figure 3.8 On the Properties Editor’s Modifiers tab, you can 
add modifiers to the active object.
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When you add a modifier, a block is added to the modifier stack, which works 
similarly to layers; if you keep adding modifiers, they add their effects to the previous 
modifiers. Keep in mind that the modifier stack works in the opposite order of layers in 
other software, such as Adobe Photoshop. In Blender, the last modifier you add is at the 
bottom of the stack, and its effect alters the effects of the modifiers above it in the list. 
The order of the modifiers is crucial in defining the resulting effects that the modifiers 
have on the object.

If you model one side of a mesh, for example, you can assign a Mirror modifier to gen-
erate the other half and then assign a Subdivision Surface modifier to smooth the result. 
The Subdivision Surface modifier should be at the bottom of the list; otherwise, the 
object is smoothed before being mirrored, and a seam may appear visible in the middle.

Copying Modifiers to Other Objects
When you assign a modifier, it affects only the active object, which is the last selected 

object (even if you have 20 selected objects). If you want that modifier to be applied to 

every object in the selection, you have two ways to do this:

 ■ Press Ctrl+L to access a menu of linking options. In this menu, you’ll find an 

option that lets you copy modifiers or materials from the active object to the rest 

of the selection.

 ■ Activate the Copy Attributes add-on in User Preferences (this add-on comes bun-

dled with Blender) and press Ctrl+C to access a special menu to copy attributes 

from the active object to the rest of the selected objects. You’ll find the modifiers 

within those attributes as well.

It’s important to know that both Ctrl+L and Copy Attributes addon’s Copy Modifiers 

option will overwrite the existing modifiers that objects in the selection have. If you 

want to keep those, using the Copy Selected Modifiers option within the Copy Attri-

butes addon’s menu will add those modifiers from the active object to the existing 

modifiers in the rest of the selected objects.

Adding a Subdivision Surface Modifier to Your Object
The Subdivision Surface modifier is one of the most common modifiers used in mod-
els, because it allows you to increase the details and smoothness of a low-resolution 
model interactively. You can change the number of subdivisions at any time to display a 
smoother surface. The modifier basically divides each polygon and smooths the result. 
As a rule of thumb, when you apply this modifier, the number of faces in your model 
is multiplied by 4 for each subdivision you apply; therefore, be mindful of the polygon 
count when setting high subdivision values. You can use this modifier to smooth your 
monkey-head object, as shown in Figure 3.9.

When you add a modifier, you get a panel in the modifier stack with options that 
are specific to the modifier you picked. Here are the main options you’ll find with a 
Subdivision Surface modifier:
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■ In the top row of the panel that encloses the modifier, you can expand/ collapse 
the modifier (by clicking the little triangle to the left), rename it (give the mod-
ifier an intuitive name when you have a lot of modifiers added to an object), 
and define the contexts in which this modifier should be visible. Two buttons 
with arrows pointing up and down allow you to change the order of the modi-
fiers when you have more than one modifier in the stack. Clicking the X button 
deletes the modifier.

■ Next, you find two buttons: Apply and Copy. Apply transfers the effect of the 
modifier to the mesh itself. It deletes the modifier, but its effect on the mesh is 
permanent. Copy duplicates the modifier.

■ In the Subdivisions section are two fields that let you define the number of sub-
divisions that the modifier will perform in the 3D Viewport and in the render. 
This option is very useful because when you’re in the 3D Viewport, you usually 
want to save resources to ensure that this view is responsive, but in a render, you 
want a high-quality result. You can set a low number of subdivisions for the 3D 
Viewport and a higher number for the render.

Figure 3.9 Subdivision Surface Modifier options and the monkey head before and after 
applying a Subdivision Surface modifier
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Tip
Subdivision Surface is a widely used modifier, so Blender comes with a keyboard shortcut 

that lets you add and control it. Press Ctrl+1 (you must have a mesh selected in Object 

Mode for this to work) to add a Subdivision Surface modifier with one subdivision. The 

number you press together with Ctrl defines the number of subdivisions shown in the 3D 

Viewport (doesn’t change the subdivision level while rendering). If the object already has 

a Subdivision Surface modifier added, use this shortcut to change its number of subdivi-

sions. Additionally, if the object has multiple Subdivision Surface modifiers, the shortcut 

will change the number of subdivisions of the first Subdivision Surface modifier in the 

stack.

Using Workbench, EEVEE, and Cycles
Blender provides different methods to display and render images, each of them with 
their uses, pros, and cons. Let’s talk about them:

 ■ Workbench: This engine runs Blender’s 3D Viewport while you’re working 
in Wireframe and Solid viewport shading modes. It’s basic, but it has some level 
of control over how things look. It’s lightweight and simple, perfect for general 
work like modeling, rigging, and animation.

 ■ EEVEE: EEVEE has been one of the greatest additions to Blender lately, and it’s 
a real-time render engine, using technologies similar to those used in videogame 
engines. It can get good-quality results very fast (as long as you have a computer 
that supports it and can run it with a good performance), although it’s based on 
tricks and sacrifices many calculations to accelerate the render time. It’s good for 
rendering animations that don’t require high levels of realism and for previewing 
scenes and materials that would be rendered with Cycles later. EEVEE is used 
when you choose the Material Preview viewport shading mode, and it shows 
at its best in Rendered viewport shading mode (when EEVEE is selected as the 
active render engine).

 ■ Cycles: This realistic renderer is included in Blender. It provides high quality 
and realism, but it’s also much slower than EEVEE, as it doesn’t use tricks or 
sacrifice complex calculations to be faster: it performs all the calculations neces-
sary to achieve the best result. If EEVEE could be compared with what you see in 
videogames, Cycles would be a render engine used for movies or general video, 
where render speed is not as relevant as image quality.

You can change the render engine that you want to use in the Render tab within the 
Properties Editor (see Figure 3.10). When you render the final image, as explained at 
the end of this chapter, the active render engine is the one that will be used.
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Figure 3.10 You can change the render engine between Workbench, EEVEE, and Cycles 
from the drop-down menu within the Render tab of the Properties Editor.

Materials Compatibility
Workbench doesn’t use materials, but EEVEE and Cycles have been designed so the 

materials are as compatible as possible between them. Of course, there are certain 

things that may work only on one of the engines or look different, given that they use 

different technologies, but in general they are surprisingly compatible.

This makes it possible to create materials using EEVEE (allowing for fast previews) and 

then render them with Cycles with minimal or no adjustments. 

Some advanced rendering effects, such as emissive materials (that emit light from 

their surface), refractions, and Subsurface Scattering, will work only in Cycles or with 

certain limitations in EEVEE.

Understanding Viewport Shading

Viewport shading defines how objects are visualized in the 3D Viewport, and it’s 
important to understand how they work before you start adding materials to the scene.

While working, you can change the viewport shading mode in the 3D Viewport 
to show Wireframe, Solid, Material Preview, or Rendered mode (see Figure 3.11), and 
different engines will be activated for different modes, although Rendered viewport 
shading mode will always display a result similar to the final render, but interactively 
and in real time, using the selected active render engine. Depending on what render 
engine you use, options for viewport shading will change:

■ Workbench Engine: Material Preview viewport shading will not be available, 
as Workbench doesn’t use materials (although colors and other properties can be 
added to objects); it’s meant only for general work and simple screenshots. Wire-
frame, Solid, and Rendered viewport shading modes all use Workbench Engine. 
A render taken from this engine would be like a screenshot, useful for quick 
playblasts to check your animations.
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■ EEVEE Engine: Wireframe and Solid viewport shading modes will use 
Workbench, but Material Preview and Rendered viewport shading modes will 
use EEVEE.

■ Cycles Engine: Wireframe and Solid viewport shading modes will use Work-
bench, Material Preview will use EEVEE, and Rendered viewport shading mode 
will use Cycles.

Whichever render engine you’re using, you’ll see their options for rendering in the 
Render tab of the Properties Editor.

Figure 3.11 Viewport Shading and visibility options. You can find them 
in the right corner of the 3D Viewport’s header.

You can also find interesting options for how the image is shown by clicking the 
Shading arrow next to the 3D Viewport’s shading mode selector. For example, Material 
Preview Mode will let you change the environment to see how the materials behave 
under different lightings, and Solid Mode will let you choose different options for how 
objects are visualized.

Real-Time Preview Rendering
In Blender, you have options to see a rendered preview in the 3D Viewport while you 

work and adjust parameters using the Rendered viewport shading. It’s very useful to 

see what’s going on in the scene and how the shadows and materials behave as you 

arrange them.

Rendered viewport shading mode, in this case, is not actually real time; it just means 

that Blender is performing the render interactively, and you can change things in the 

scene as it’s rendered. The speed of the render depends, of course, on your comput-

er’s processing speed. For Cycles, a powerful CPU or GPU is recommended for faster 

performance; EEVEE relies mainly on GPU.

While using Rendered viewport shading mode, you can choose to show or hide manip-

ulators, object outlines, and so on from the Overlays menu on the 3D Viewport’s 

header.
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Switching Viewport Shading Modes
To switch viewport shading modes, you can simply click the button for that mode in 
the 3D Viewport’s header (refer to Figure 3.11).

Alternatively, and to speed things up, you can use keyboard shortcuts:

■ Press Z to launch the viewport shading pie menu, and choose one of the options.
■ Press Shift+Z to switch between the current viewport shading mode and Wire-

frame viewport shading mode.

Managing Materials
Materials define how an object looks, such as what its color is, whether the object is 
dull or shiny, and whether it is ref lective or transparent. With materials, you can make 
an object look like glass, metal, plastic, or wood. In the end, both materials and light-
ing define how your objects look. In this section, you see how to add materials to your 
objects by using both Blender Render and Cycles.

On the Materials tab (the red sphere with a checkered pattern icon) of the Proper-
ties Editor, you can add new materials or select existing ones from the drop-down list 
shown in Figure 3.12. A single object can have multiple materials, and these materials 
appear in the list at the top of the material properties. You can add and remove new 
slots for materials by clicking the + and - buttons on the right side of the list, and you 
can assign each of those materials to a selection of faces when you’re in Edit Mode.

Figure 3.12 Use this menu on the Material Properties tab of the Properties 
Editor to add materials. Keep in mind that the Material tab has been isolated 

for clarification; in the Properties Editor, you’ll find it within the rest of the tabs.

Adding and Adjusting Materials
Advanced materials require the use of node trees in the Shader Editor, but don’t worry; 
for now, I’ll keep things simple. Inside a material, you’ll find the Surface panel, which 
includes various types of surface shaders, such as
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 ■ Diffuse: Creates a basic material with only color—no shine, ref lection, or other 
special properties.

 ■ Glossy: Makes the material ref lective and shiny.
 ■ Emission: Makes the material emit light into the scene.
 ■ Transparent: Lets light pass through the material.
 ■ Glass: Simulates a glass surface.
 ■ Principled BSDF: Includes many of the properties provided by the others, so it’s 

a very useful shader type, and conveniently, it’s the one you get by default when 
you create a new material. 

 ■ Mix: Mixes two shaders to achieve a more elaborate effect.

Many surface shaders are available; these are just some of the main ones. Each of the 
shaders has different parameters to control how light affects that shader, such as color 
and roughness. Accessing nodes makes it easier to create complex and custom materials 
by combining the effects of some of the shaders and using textures. (See Chapter 10, 
“Materials and Shaders.”)

Remember that these materials are almost completely compatible between EEVEE 
and Cycles, so for simple cases, the same settings will work in both engines (even 
though there may be some differences in the result, given the different approaches that 
both engines used to calculate the final image).

Tip
When working with materials, it’s recommended that you work with Material Preview or Ren-

dered viewport shading in EEVEE, as they will let you see how the material looks in real time.

To add materials with different colors to your scene, you just need to select each 
object and create a material from the Material Properties tab in the Properties Editor. 
Follow this procedure:

 1. Select the monkey head.

 2. Go to the Material Properties tab of the Properties Editor.

 3. Add a new material by pressing the New button and name it properly to make it 
recognizable.

 4. You’ll get the options for a Principled BSDF shader. Adjust the base color param-
eter to choose the color you’d like for the material. Play with other parameters of 
the material to see how it changes.

 5. Repeat the process with a new material for the f loor plane.



62 Chapter 3 Your First Scene in Blender

Turning On the Lights
Now that you have materials set up, it’s time to make the scene look more realistic with 
some light and shadows. Lights are also compatible between EEVEE and Cycles, even 
though some of their options are different. For basic use, however, there shouldn’t be 
any problem. (Chapter 14, “Lighting, Compositing, and Rendering,” provides more 
information about lighting.)

Light Options
There are different types of lights with different properties, but there are two proper-
ties that all of them share and that are compatible in both EEVEE and Cycles: Color 
and Power. Color, as the name implies, will change the color of the light, and Power 
will increase or decrease its intensity (it’s measured in Watts).

To access the light properties, select a light in your scene, and the Object Data tab of 
the Properties Editor should change into a teal light bulb. From that tab, you will find 
options to change the light type and its properties.

Remember that using EEVEE in Rendered viewport shading mode, you should be 
able to preview the lights’ effect on your scene as you adjust them.

Adding Lights to Your Scene
Follow these steps to create a basic lighting scheme for your scene (and remember that 
you can access the menu for adding new objects to the scene by pressing Shift+A):

 1. Select the light in your scene (or create a new one if you don’t have a light yet).

 2. Duplicate the light, and place it on the other side of the scene to fill the shadow 
areas.

 3. Adjust the Color and Power of your lights so that the one on the right is brighter 
(this will be your main light), while the one on the left is dimmer and a different 
color (this will act as a fill light, to prevent the area in the shadow from being 
completely dark).

Moving the Camera in Your Scene
You need a camera in your scene, of course, so that Blender knows the point of view to 
look from when it takes the final render. Follow these steps to position the camera:

 1. Select the camera in your scene or create a new one (Shift+A) if you deleted it 
previously.

 2. Place the camera so that it focuses on the monkey head from a point of view that 
appeals to you. You can divide the interface into two 3D Viewports. In one of 
those views, you can look through the camera (NumPad 0), and in the other 
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view, you can adjust the placement of the camera. Alternatively, you can use 
Walk Mode or Fly mode (Shift+`) to position and orient the camera while you’re 
in Camera View.

Figure 3.13 shows what your scene should look like at this point of the process.

Figure 3.13 At this point, your scene should look something like this image. The 
monkey head is on the floor, the camera is pointing at it, and two lights illuminate 

everything in the scene.

Rendering
Rendering is the process that converts your 3D scene to a 2D image or animation. 
During this process, Blender calculates the properties of materials and lights in the 
scene to apply shadows, ref lections, refractions, and so on—everything you need to 
build your cool final result and turn it into an image or a video.

Whether you use EEVEE or Cycles, you would access options for rendering within 
the Render tab in the Properties Editor.

Select your desired render engine. For such a simple scene, not many changes should 
be made, but here are a couple of things you can try:

 ■ For EEVEE: If you want the surfaces to ref lect other objects, you can enable 
Screen Space Ref lections in the Render Properties tab.

 ■ For Cycles: Cycles calculates light paths and bounces throughout the scene. This 
generally means that the more calculations (and more render time), the cleaner 
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the result. If you have a low samples count, you’ll have noise in the resulting 
render, as the pixels still don’t have enough information to display the complete 
result. You can increase the render samples amount in the Render Properties tab 
of the Properties Editor to get a cleaner image.

Enabling GPU Rendering with Cycles
GPUs can be much faster than CPUs for rendering with engines such as Cycles. If you 

want to use your GPU to render the scene, follow these steps:

 1. Open User Preferences.

 2. On the System tab, you’ll find a panel called Cycles Render Devices. Depending on 

your graphics card, some of the options within that panel will be available. Make 

sure to select one of them and enable the GPU or GPUs that you want to use.

 3. Go back to your scene, and within the Render Properties, you’ll find the Device 

menu (right under the render engine selector). Select GPU.

 4. Finally, go to the Performance panel in the Render Properties, and set the Tile 

Size to a number such as 64, 128, 256, 512... try rendering the scene with differ-

ent values in the Tile Size, as depending on your GPU, you will get better results 

with different sizes.

Tile Size defines the size of the squared parts of the image that the CPU or the GPU 

can render at a time. Generally, CPUs work better with small values (16, 32, 64, and 

so on), while GPUs work better with bigger values (128, 256, 512, and so on). Setting 

the right value for your hardware can help you get faster results, but keep in mind that 

in general, rendering with Cycles requires high-performing equipment, so anything that 

isn’t very powerful may be very slow, regardless of the settings.

In User Preferences, you can also choose if you want to use CPU and GPU to render 

together (you just have to enable both the CPU and GPU). If you choose this option, 

it’s recommended to use little tile sizes so that the CPU doesn’t lag behind GPU while 

rendering.

Now you’re ready to launch the final render. But first, let’s learn how to save the 
.blend file.

Saving and Loading Your .blend File
Now you’re at a good point to save your file. Rendering can take some time, and some-
thing can go wrong in the meantime (such as power failures or software crashes) that 
could cause you to lose your work. That’s why it’s recommended that you save your 
file often.

You can save your file by pressing Ctrl+S. If you’re saving a file for the first time, 
Blender displays a menu where you can select the location where you want to store your 
file and name the file. If you’ve saved the file previously, press Ctrl+S to overwrite the 
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previous version. If you press Shift+Ctrl+S, Blender displays the Save menu again so 
that it allows you to create a new version of the file with a different name.

To open a file, press Ctrl+O. Blender shows you the folder navigation menu, where 
you can look for the .blend file you want to open. On the File menu, you can also 
access the Open Recent option, which shows you a list of the latest files you’ve worked 
on so you can open them quickly.

You don’t need to use those shortcuts, of course; you can always choose the Save, 
Save As, Save Copy, and Open options from the File menu.

Save Copy doesn’t have an assigned keyboard shortcut and it’s a bit unusual, so what 
does it do? Well, it’s similar to Save As except that it saves the current status of the 
scene in a file, but then you keep working on the original instead of in the new file.

Tip
There’s a little trick for saving different versions of a file really fast. Sometimes, you want 

to save your progress in a new file, so you’ll have different files from different parts of the 

process and can go back to a previous version if necessary. Choose Save As from the File 

menu (or press Shift+Ctrl+S), and press the NumPad + key. Blender automatically adds a 

number to the filename. If the filename is already numbered, Blender adds 1 to it.

Launching and Saving the Render
Before launching the render, remember to select the desired Render Engine from the 
Render tab in the Properties Editor. Remember as well that the image format can be set 
up in the Output tab of the Properties Editor. Then, you can launch it in several ways:

 ■ Press F12 for a still render.
 ■ Press Ctrl+F12 to render an animation.
 ■ Select the Render Image or Render Animation options from the Render menu 

on the main menu at the top left of Blender’s interface.

By default, the render will appear in an Image Editor in a new window. You can 
change this behavior so the render shows up within the main interface: for example, 
turning the biggest area into an Image Editor and displaying the render in it.

To save the image once it’s rendered, you can do it in different ways:

 ■ In the Image Editor where the render is shown, go to the Image menu within the 
header, and select the option to save the image.

 ■ In the same Image Editor, you can launch the Save menu by pressing Alt+S or 
Shift+S.

When you’re rendering an animation, images are automatically saved after being 
rendered, using the format, name, and destination defined in the Output tab of the 
Properties Editor.
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You can press Esc after the render to go back to switch to the main interface again. 
If you chose to display the render within the main interface, the Image Editor will turn 
into the previous editor type, while if the render is shown in a different window, it will 
remain open (you can close it).

Figure 3.14 shows the images that result from both engines’ renders. Given that the 
scene is very basic, there are no many differences between EEVEE and Cycles renders, 
although some subtle differences can be spotted. Cycles, for example, has bounced light 
that spreads some of the monkey head’s red color on the ground and makes the areas in 
the shadows a bit brighter, making for more realistic lighting. Still, EEVEE got very close 
with a fraction of the render time. In complex scenes with complex materials, you will 
find a more noticeable difference, but for now, I just wanted you to try both to see how 
easy it is to switch between them, given the high compatibility of materials and lights.

Figure 3.14 Resulting renders. Left: EEVEE. Right: Cycles.

Summary
In this chapter, you learned how to create and transform objects; add modifiers, lights 
and materials; and launch a render. This chapter gave you a lot to process, but I hope 
that you now know the basics of interacting with your scene. You’re ready for the more 
extensive information in the chapters that follow.

Exercises
 1. Create and manipulate a few objects.

 2. Add some other modifiers and play with them to see their effects.

 3. Try different things with EEVEE and Cycles to get acquainted with the differences 
between them.

 4. Add more lights to the scene and play with materials to change the results.
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Numbers
2D animation, 373
2D cursor, UV Editor, 186
2D image-editing software, 217–218
3D texturing software, 217, 221–222
3D camera, 330
3D cursor

3D Viewport editor, 27
adding neck to jacket, 159
adjusting camera motion, 342
detailing backpack and jacket, 157
main functions of, 35–37
posing characters without skeletons, 157
rigging eyes, 288–289

3D models
character design using, 88
making character reference images for, 

86–87
painting with 2D texture. See Unwrapping 

and UVs
vs. 2D references, 134

3D vector curves, character design, 88
3D Viewport

defined, 19
displaying UV text grid in your model, 

195–196
elements, 26–27
Live Unwrap in, 198
manipulators, 43–44
Move, Rotate, Scale objects with Active 

Tools, 42–43
navigation gizmos, 33
Pivot Point and Transform Orientation, 45
regions, 27–29
Texture Paint interaction mode, 207–208
Texture Paint Workspace, 206–209
viewing animation smoothly, 321
Workspace options, 23

3D Viewport header
accessing modeling tools, 94
adding fingers to hand, 166–167

animation controls in Timeline, 316
creating objects, 41
enabling manipulators, 44
Interaction Mode menu, 52, 94
navigating from View menu, 33
numerically precise transforms, 46–47
Pivot Point popover, 35
proportional editing menu, 96–97
Select menu, 98–100
Shade Smooth and Shade Flat options, 53
Snap icon, 45
snapping tools, 124
Texture Paint interaction mode, 207–208
understanding, 29–30
Viewport Shading modes, 59–60
X-Ray options, 125

A
Action Editor

creating walking animation, 321
NLA Editor loads actions saved in, 319
repeating walking animation with NLA 

Editor, 324–325
works with Dope Sheet editor, 317

Active Keying Sets panel, keyframes, 314–315
Active selection, objects, 33
Active Tool and Workspace Settings tab, 

Properties Editor, 22–23
Active Tools

enabling 3D cursor, 37
moving, rotating, and scaling objects, 

42–43
performing selections with, 35
pros and cons of, 43
Texture Paint interaction mode using, 

207–208
working in Weight Paint Mode, 284

Adaptive Sampling, rendering in Cycles, 250
Add Bone Constraint button, 263
Add Driver, 299
Add menu, Compositor, 353–354

Index
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Add-Ons, 375–376
Add-Ons tab, User Preferences, 38
Add Shader, 229–230, 242
Adjust Last Action menu, stripping numbers, 

291
Adjust Last Operation menu

creating new bones, 260
creating objects, 41–42

Adjust Last Operation panel
blocking basic shape of face, 141
using Bevel tool, 101
using mesh modeling tools, 94

Adjusting UVs, 198
Adjustments, rigify rig, 276–277
Advanced Options, Rigify Buttons panel, 276
Agent 327: Operation Barbershop (2017), 6
Alignment tools, UVs, 198
Alpha Over node, Cycles, 360–361
Alpha (transparency or opacity) channel

masks and, 230–231
materials, 232
Viewport Display options for eye materials, 

238
Ambience, with volumetrics, 239
Ambient Occlusion (AO), rendering in 

EEVEE, 248
Anatomy

marker, 335–336
node, 351–352

Animation
character production stage, 74
creating to move bones you are weighting, 

286
of linked character, using proxies, 310
production stages of film, 72

Animation, character
exercises, 326
overview of, 311
posing, 312–315
summary, 326
using character's rig, 311–312
walk cycle, 320–326
working with animation editors, 315–320

Animation curves, in Graph Editor, 318
Animation editors

common controls and tips for, 319–320
Dope Sheet editor, 317
Graph Editor, 317–319

Non-Linear Animation Editor, 319
Timeline, 316–317
working with, 315

Animation output, setting, 365–366
Animation tab, User Preferences, 38
Anisotropic BSDF shader, 240
Annotations tool, 121
AO (Ambient Occlusion), rendering in 

EEVEE, 248
Appearance, character design, 77
Appending

reusing character in different scenes, 308
working with collections, 308–309

Areas, Blender UI
maximizing and making it full-screen, 18
resizing, 16
splitting and joining, 17
swapping and duplicating, 17–18

Armature Deform group, 283
Armature Layers panel, Properties Editor

armature layers, 274–275
enabling deformer bones only, 281
organizing bones, 273

Armature menu, 3D Viewport header, 268
Armature modifier, skinning, 283–284
Armature Properties tab, Properties Editor, 

274–275
Armature tab, Properties Editor, 267, 289
Armatures

adding constraints, 262–264
bone hierarchies, 261–262
character rigging workf low, 256
defined, 255
forward and inverse kinematics, 264
manipulating bones, 258–260
modifying when linked in scene with 

proxies, 310
moving bones to armature layers, 303
Object, Edit, and Pose Modes, 261
practicing with bones and IK constraints, 

264–267
tips before you start rigging, 267–268
using in Object mode, 52
working with, 257

Arms. See also Torso and arms, modeling
animating character's rig, 311–312
shading character, 243

Auto Grab option,F2 add-on, 122
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Auto Keyframing option, 313
Auto Merge, 3D Viewport header, 123, 

166–167
Auto Perspective option, 3D scene 

navigation, 32
Auto-Save Preferences, 39
Automatic

effects, 3D texturing software, 222
forward and inverse kinematics, 264
retopology, 130
rig generation, 257
rigging process in Rigify, 269

Automatic Weights
adding Armature modifier, 283–284
do not update after adding Armature 

modifier, 299
knowing which objects don't need weights, 

281
testing skinning process, 293

Automatically Pack into .blend, 215
AutoName Left/Right, naming bones, 290
Average Islands Scale tool, packing UVs, 203

B
Background

applying current footage to Camera view 
as, 342

creating/testing scene lighting, 346–347
play animation to view markers in black, 

338
rendering in Cycles, 358
shader, 247–248

Background’s Alpha, scene lighting, 346
Backpack

defining arms and torso, 154–155
detailing, 156–158

Badges
modeling, 177–178
packing UVs, 202–203
unwrapping, 201

Base Color (Diffuse Color) property, 
materials, 232

Base design, 79–81, 83–84
Base skeleton, creating rig, 268
Base texture, 214–215
Basis, shape key, 295–296
Beauty option, Fill tool, 108

Belt
detailing, 157–158
finishing, 158
shading character, 243

Bevel tool, 100–101, 109
Bevel Vertices tool, eyes, 144
Big Buck Bunny (2008), 6
Bisect tool, 102
.blend file

every object belongs to collection in, 309
packing image into, 215
saving and loading, 64–65
saving Workspaces, 22
before you begin painting texture, 209

Blender 2.83 LTS (long-term support), 7–8
Blender Foundation, 6–10
Blender Institute, 6
Blender, introduction

Blender Foundation and development, 8–9
commercial software, 4–5
community, 10–11
development income channels, 10
exercises, 12
history of, 6–8
open-source software, 5
selling works created with, 5–6
summary, 11–12
understanding, 3–4

Blender Store, 10
Blocking

basic shapes for torso and arms, 152–154
face's basic shape, 139–140

Bloom, rendering in EEVEE, 248
Blur brush, 286, 293
Blurry footage, when shooting video, 331
Body language, designing great characters, 76
Bone groups, disabling Deform option, 280
Bone Groups panel, 273–274
Bone hierarchies, 255, 260–262
Bone Layers menu, 274
Bone Properties tab, Properties Editor, 259
Bone Settings menu, 280
Bone tab, Properties Editor, 280
Bones

adding custom shapes to, 305–306
adding to deformation, 292–293
character rigging workf low, 256
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configuring drivers, 301
creating armature by manipulating, 

258–260
creating face controls, 298–299
creating new, 260
inside of rig is made of, 255–256
mirroring, 291
moving to armature layers, 303
naming automatically, 290
organizing, 273–277
parenting objects to, 281–282
resetting to original positions, 285–286
tips before you rigging, 267–268
working in Object, Edit, and Pose Modes, 

261
Boolean (Intersect) tool, 102–103
Boots

adding details to, 83
modeling, 161–163
packing UVs, 202–203
unwrapping, 200–201

Border selection, 98
Boundary option, Inset tool, 109
Box modeling, 129
Box selection

connecting and manipulating nodes, 354
selecting objects, 33
using Active Tools, 35

Branches
Blender development versions, 9
of node tree, 350–351

Bridge Edge Loops tool, 104
Bridge tool, 121
Brushes

Texture Paint interaction mode, 207–209
Weight Paint Mode, 284

Bump property, materials, 232–233
Buttons, adding custom, 303–305

C
Caching footage, 334
Camera

in 3D Viewport editor, 27
moving in your scene, 62–63
render test scene setup with lights and, 246
taking reference images from background 

images on, 131
Camera Properties tab, Properties Editor, 346

Camera Solver constraint, 340–341
Camera tracking

adjusting camera motion, 341–342
anatomy of a marker, 335–336
applying tracked motion to camera, 

340–341
character postproduction stage, 74
configuring camera settings, 339
exercises, 343
loading your footage, 333–334
overview, 329
shooting video for easy tracking, 330–331
solving camera motion, 339–340
summary, 343
testing, 343
tracking camera motion, 333
tracking features in footage, 336–338
understanding, 329–330
using Movie Clip Editor, 332–333

Camera view, navigating 3D scene, 32
Cap

adding details to, 82–83, 170–172
giving personality with, 81–82
modeling base of, 168–169
packing UVs, 202–203
shaping hair under, 172–175
unwrapping, 200–201

Cartoon shaders with EEVEE, 2D animation, 
373

Cascade Size, rendering in EEVEE, 248
Caustics, in Cycles, 245
Chain of bones, 258, 260
Chamfer tool, 3ds Max, 101
Channels

masks and alpha, 230–231
of materials, 216, 231–233
other texture, 221

Character
creation plan, 73–74
shading. See Shading your character
texture painting. See Texture painting
unwrapping rest of, 200–201

Character design
adding color, 84–85
appearance, 77
base design, 79–81
context of story in, 76
description of character, 75–76
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details, 82–83
exercises, 89
finalizing, 85
head, 81–82
other design methods, 88–89
overview of, 75
personality, 76
reference images, 86–88
refined design, 83–84
silhouettes, 78–79
style, 77
summary, 89

Character modeling
boots, 161–163
cap, 168–172
exercises, 180
eyes, 135–139
face. See Face
final details, 176–179
hair, 172–175
hands, 164–168
legs, 159–161
mesh topology and, 127–129
methods, 129–131
overview of, 127
setting up reference images, 131–135
summary, 180
torso and arms. See Torso and arms, 

modeling
Character rigging

adjusting Rigify rig, 276–277
animating using, 311–312
armature layers, 274–275
in character production stage, 73
creating custom shapes, 305–306
defining rigs, 255–256
defining workf low, 256–257
enabling Rigify add-on, 267
exercises, 310
final retouches, 306
organizing bones, 273
overview of, 255
reusing character in different scenes, 

307–310
summary, 310
tips before you start, 267–268
understanding Rigify rig, 275–276

using Rigify to generate Jim's rig, 268–273
working with armatures. See Armatures
working with skinning. See Skinning

Checker Deselect tool, selection, 100
Cheeks

adding blush to, 219
creating face controls, 298
creating facial expression with, 296
defining face's shape, 143
modeling basic face shape, 142
weight painting, 293

Chest badge deformation, 294–295
Choose Only Selected Curves Keyframes, 

Graph Editor, 320
Circle selection, 33, 35
Circle tool, LoopTools, 121, 166–167
Classes, node, 350–351
Clear Parent, bone hierarchies, 260
Clear Seam tool, UV Mapping, 188–189
Clear Transform option, testing rig in Pose 

Mode, 268
Clichés, designing character appearance, 77
Clip Display, Movie Clip Editor, 337
Clipping option, Mirror modifier, 141, 159
Cloth simulation, 372
Clothing, checking deformations, 287
Cloud, Blender, 10
Collapse/expand nodes, 354
Collapse option, Merge tool, 114
Collections, 134, 308–309
Color

adding base, 218–219
analyzing real footage before adding lights, 

345–346
changing UV test grid to white for line 

details, 210
character design details, 82–83
configuring brush, 205
masks and image, 230
UV test grid in, 195–196

Color property, lights, 62
Commercial software, 4–5
Communicator earpiece

character design details, 82–83
modeling, 177
shading character, 243

Community, Blender, 10–11
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Compositing
anatomy of nodes, 351–352
in character postproduction stage, 74
getting started with nodes via Node Editor, 

352–355
of nodes in Cycles, 359–361
overview of, 349
previewing result, 355–356
summary, 366
two main methods of, 349
understanding nodes, 349–351
your scene in Cycles, 356–357
your scene in EEVEE, 364–365

Compositing Workspace, 359–361
Compositor Backdrop, 355
Compositor Editor

defined, 19
getting started with nodes, 352–354
previewing result, 355–356

Conditions, for painting textures, 210–211
Configuration, driver, 300–303
Connect tool, 104–105
Connected Only option, proportional 

editing, 97
Connected option, defining bone hierarchies, 

260
Connecting UVs, 199
Connections, node, 352, 354–355
Constraints

adding bone, 262–264
Camera Solver, 340–341
character rigging workf low, 256
forward and inverse kinematic, 264
inside rig, 256
moving object along a curve, 325–326
object vs. bone, 263
practice with bones and IK, 264–267
using eyedropper for bone, 264

Contact Shadows, rendering in EEVEE, 248
Context of story, in character design, 76
Contextual menu

accessing modeling tools, 95
connecting and manipulating nodes, 354
UV Editor, 187

Control bones, 256
Controls, creating face, 298–299
Converter nodes, 352

Copy Attributes add-on, User Preferences, 55
Copy Pose animation, walking, 323
Copying, modifiers to other objects, 55
Correlation, marker settings, 336
Cosmos Laundromat (2015), 6–7
Create New Collection, 309
Crowdfunding, Blender development, 10
Cube

blocking basic shape of face, 141–142
modeling basic hand shape, 164–166

Cube Projection tool, UV Mapping, 190
Current material, Material Properties tab, 

238
Current selection, Material Properties tab, 238
Current UV layer, UV Editor, 187
Cursor, 2D, 186
Curve tool, LoopTools, 121
Custom buttons, Rigify script adding, 

303–305
Custom shapes

assigning to bones, 256
character rigging workf low, 257
creating, 305–306

Cycle, walking animation is a, 321
Cycles

Color and Power light options, 62
creating shadow catcher, 357
Displacement, 239–240
EEVEE versus, 233
Emission shader, 240
final render, 361
GPU rendering, 64
history of Blender, 6–7
Maps Baking tool, 375
rendering/compositing scene, 356–367
rendering images, 57–58, 63–65, 250–252
rendering in EEVEE versus, 66
shading eyeballs, 245
shadows more accurate in, 251
switching between EEVEE and, 233–234
testing scene lighting, 348–349
viewport shading, 59

Cylinder Projection tool, UV Mapping, 190

D
Datablocks, 49–51, 321
Default cube, 3D Viewport editor, 27
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Deform bones
character rigging with, 256–257
enabling only, 281
parenting objects not needing weights to, 

282
protecting with layers, 310
selecting while you paint weights, 285

Deform modifier, 54
Deform panel, Bone tab of Properties Editor, 

280
Deformations

checking after weighting character, 287
checking for unwanted, 293
on chest badge, 294–295
disabling as option for bones, 280
lattices for eyeball, 137–138
mirroring and adjusting eyes, 138–139
requiring good mesh topology, 128
rigging eyes, 288–289
rigging jaw, 291–292
skinning and, 278
skinning eyelids and jaw, 292–293
vertex groups and, 278–279

Delete and Dissolve tools, modeling, 105–106
Delete tool, 260
Denoising

enabling in Cycles, 250
rendering in Cycles, 358

Density, good mesh topology, 128
Depth parameter, reference image setup, 132
Description, designing character, 75–76
Deselect all, objects in scene, 35
Deselect, material slots, 237
Design, character preproduction stage, 73
Details

adding character design, 82–83
painting texture, 2-D image-editing 

software, 219
Development, Blender, 4, 10
Development, commercial vs. open-source 

software, 4–5
Diffuse BSDF shader, 240, 241–242
Diffuse Color property, materials, 232
DirectX, calculating normal maps, 221
Disconnect, bone hierarchies, 260
Displacement option (Cycles only), 239–240
Display Only Axis Aligned, reference images, 

133

Display panel, 186, 267
Display Perspective, reference images, 133
Dissolve Faces tool, modeling base of cap, 

168–169
Donations, Blender development via one-

time, 10
Dope Sheet editor

animation with, 317
defined, 19
repeating walking animation, 324
retiming keyframes, 323

Downloading Blender, 13
Drivers

configuring, 300–303
controlling face shapes, 299
setup menu, 299–300

Drivers editor, 19, 301–302
Duplicate nodes, 354
Duplicate tool

bones, 259
modeling with, 106

Duplicating areas, 17–18
Dynamic Topology (Dyntopo) sculpting, 374

E
Earpiece. See Communicator earpiece
Ears

adding to face, 147–149
modeling communicator earpiece. See 

Communicator earpiece
packing UVs, 202–203

Eclipse Public License (EPL), open-source 
software, 5

Edge f low, selecting loops and rings, 97–98
Edge loops

blocking basic shape of face, 141–142
creating eyeball, 135–136
in good mesh topology, 127
joining using Bridge Edge Loops tool, 104
selecting, 98

Edge Offset tool, 114–115
Edge rings, 98
Edges

defined, 93
marking as seams for UV unfolding, 

193–194
selecting, 94
working with, 93–95
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Edit Mode
accessing unwrapping menus, 188
adding details to cap, 171
adjusting Rigify rig, 277
armature layers, 274
assigning vertices to groups only in, 279
changing bone hierarchies from, 261
character rigging workf low, 256
creating skeleton/modifying bone 

structure, 258
defining hierarchy of bones, 260
deforming eyeball using lattices, 137–138
detailing backpack and jacket, 158
disabling Deform option for bones, 280
interaction modes in, 51–52
marking seams for UV unfolding, 193–194
packing UVs, 203
practicing bones and IK constraints, 

264–267
rigging eyes, 289
selecting vertices, edges, and faces, 94
selections in. See Selections, making
walking along path, 325–326
weight values, 287
working with armatures, 261

Editing tab, User Preferences, 38, 318
Editor Menu, 3D Viewport header, 29
Editor Type Selector, 3D Viewport header, 29
Editors

default, 16
that use nodes, 352
types of, 18–21

Edits, defined, 30
EEVEE (real-time render engine)

in Blender version 2.80, 3
cartoon shaders, 373
Color and Power light options, 62
differences/compatibility between Cycles 

and, 233
Emission shader in, 240
final render in, 365
history of, 7
Material Properties tab settings, 240
rendering in, 63–65, 248–249
rendering in Cycles versus, 57–58, 66
setting up scene lighting, 348–349
shading eyeballs, 244

switching between Cycles and, 233–234
viewport shading, 59

Elbows
adding details to suit, 82
adjusting skeleton to 3D model, 272
defining arms and torso, 154–155
modeling basic shape for arms, 152–154
painting with blur brush, 286
requiring complex deformations, 128

Elements, texture, 215–216, 218
Elephants Dream movie project, 6
Emission property, materials, 232
Emission shader, 240
Emitter geometry, particles, 371
Empties, defined, 131
Empty Groups, adding Armature modifier 

to, 283
Enable Display Orthographic, reference 

images, 133
Envelope Weights, adding Armature modifier 

to, 283
Environment, render test scene setup, 246–248
EPL (Eclipse Public License), open-source 

software, 5
Exercises

Blender UI, 40
camera tracking, 343
character animation, 326
character design, 89
character modeling, 180
character rigging, 310
introduction to Blender, 12
materials and shaders, 252
modeling tools, 125
painting textures, 224
project overview, 74
rendering, 366
texture painting, 224
user interface (UI), 40
your first scene in Blender, 66

Export UV Layout, 2-D image-editing 
software, 218

Exporting
3D texturing software, 222
3D model, 221
final render, 365–366

Extrude Faces Along Normals, 158, 163
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Extrude tool, 106–109
Eye icon, hiding/showing reference images, 

134
Eyeballs

assigning material slots to, 237
creating, 135–136
deforming using lattices, 137–138
shading character, 243–245

Eyebrows, modeling, 176–177
Eyedropper, select objects from different 

menus with, 264
Eyes

blocking basic shape of face, 142
creating face controls using bones, 298
defining on face, 145–146
defining shape of, 144
deforming eyelids, 292–293
edge f low around, 140
mirroring and adjusting, 138–139
mirroring eye rig, 290
overview of, 135
rigging, 288–289
skinning jaw and, 292–293

F
F2 add-ons, modeling with, 122
.fbx format, exporting 3D model, 221
Face

adding ears, 147–149
blocking basic shape, 140–142
building inside of mouth, 149–150
controlling shapes using drivers, 299–303
creating controls for, 298–299
defining eyes, mouth, and nose, 145–146
defining shape of, 142–144
rigging jaw, 291–292
studying topology of, 139–140

Faces (polygons)
defined, 93
Knife tool cuts, 110
mesh topology uses quads for, 128
Poke tool for, 115
selecting, 94
separating UVs, 199
Solidify tool for, 118
Split tool for, 119
working with, 93–95

Facial rig
adjusting Rigify script to add custom 

buttons, 303–305
adjusting skeleton to 3D model, 271
creating, 288–289
creating face controls, 298–299
mirroring bones, 290
mirroring eye rig, 290
mirroring shapes, 298
modeling shape keys to build, 295–297
naming bones automatically, 290
organizing, 303–305
possible side effects of mirroring bones, 290
rigging jaw, 290–291
sending bones to proper layers, 303
skinning eyes and jaw, 291–292
using drivers to control face shapes, 

299–303
working on full character pose first, 275

Falloff selection, proportional editing, 97
Features

developing in Blender, 9
shooting video for tracking using 

recognizable, 331
shooting video for tracking using static, 

331–332
tracking in footage, 336–338
tracking when obscured by foreground 

frames, 337
Features, other Blender

2D animation, 373
add-ons, 375–376
Maps Baking, 375
Python scripts, 376
retopology, 375
sculpting, 374
simulations, 371–372
summary, 376–377
VFX: masking, object tracking, and video 

stabilization, 373
video editing, 374

Feet
character design with silhouettes, 78
creating, 265
creating poses for walk cycle, 322–323
on f loor, adjusting sizes of 3D models, 270
on f loor, modeling torso/arms, 150–151
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modeling boots for. See Boots
using IK/FK to control position on 

ground, 264, 311
walking along a path, 325–326

File Browser, 20
File Paths tab, User Preferences, 38
Fill and Grid Fill tool, modeling with, 108
Fill layer, 3D texturing software, 222
Film panel

rendering in Cycles, 250
rendering in EEVEE, 248

Film without visual effects, production 
stages, 70–71

Filter Add-Ons option, Workspace, 22
Filters menu, Outliner, 134, 348
Final design, of character, 85
Final render

compositing before, 19, 349
in Cycles, 361
in EEVEE, 365
exporting, 365–366
launching, 65–66, 366
Maps Baking achieves look of, 375
Rendered viewport shading mode similar 

to, 58
showing/hiding objects in, 347–348

Fingers
adding to hand, 166–168
adjusting Rigify rig, 276, 277
modeling basic shape, 165–166

First scene
arranging objects, 48–49
creating objects, 41–42
exercises, 66
f lat or smooth surfaces, 53
interaction modes, 51–52
lighting, 62
managing materials, 60–61
modifiers, 54–57
moving camera in, 62–63
naming objects/using datablocks, 49–51
overview of, 41
rendering, 63–66
transform objects with Active Tools, 42–43
transform objects with keyboard shortcuts, 

46–47
transform objects with manipulators, 44–46

transform objects with menus, 47–48
Viewport shading, 58–60
Workbench, EEVEE, and Cycles, 57–58

FK (forward kinematics)
animating your character, 311–312
character rigging, 264

Flat surfaces, applying, 53
Flatten tool, LoopTools add-on, 121
Flip Names, mirrored bones, 291
Floor button, adjusting camera motion, 

341–342
Floor, creating shadow catcher in Cycles, 357
Floor grid, 27, 347
Fluid simulation, 372
Fly Mode

moving camera in your scene, 63
navigating 3D scene, 33

Focal length, shooting video for easy 
tracking, 332

Follow Path constraint, moving object along 
a curve, 325

Foot. See Feet
Footage

analyzing before adding lights, 345–346
tracking camera motion, 333–334

Forks, bone hierarchy and, 262
Forward kinematics (FK)

animating your character, 311–312
character rigging, 264

Frame limit, monitoring tracking, 338
Frame range, animation editor controls, 316, 

319–320
Frames per second (fps), 320, 334
Frames, tracking, 337
Freestyle, 2D animation, 373
Fresnel effect, materials, 226

G
General Public License (GPL), GNU, 5, 8
General Public License (GPL), open-source 

software, 5
Generate modifier, 54
Generate Rig button, 276–277
Geometry

adding ears, 147–149
blocking basic shape of face, 140–142
creating eyeball, 135–136
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defining eyes, mouth, and nose, 145–146
defining face's shapes, 143
deforming eyeball using lattices, 137–138
modeling basic shapes for torso and arms, 

152–154
modeling legs, 159–161

Gizmos, 3D Viewport navigation, 33
Glass shader, 240
Global View

modeling with, 124
navigating 3D scene, 32

Glossiness (roughness) property, 232, 243
Glossy BSDF shader, 240, 241–242
Gloves

character design details, 82–83
shading character, 243
unwrapping, 200–201

GPL (General Public License), GNU, 5, 8
GPL (General Public License), open-source 

software, 5
GPUs, enabling rendering with Cycles, 64
Graph Editor

animation with, 317–319
Choose Only Selected Curves Keyframes, 

320
defined, 19
Normalize option, 320
tweaking animation curves, 324

Grayscale texture, Displacement (in Cycles), 
239

Grease Pencil, 317, 373
Groups, bone, 273–274, 280
Groups, duplicating connected node, 354
Groups, vertex, 278–279
Grow and shrink selection, 98
Grow selection, 98
GStretch tool, LoopTools, 121

H
Hair

adding natural details to, 174–175
base design for character, 80–81
options for creating, 172
shading character, 243
shaping locks of, 172–174
simulation, 371–372

Hair BSDF shader, 240

Hands
adding fingers and wrist, 166–168
common errors when modeling, 164
modeling basic shape, 164–166
packing UVs, 202–203
unwrapping, 201

Hardware, recommended, 13–14
Hat. See Cap
Head. See also Face; Facial rig

character design for, 81–82
character reference images for 3D model, 

86–87
checking deformations, 287
packing UVs, 202–203

Header
3D Viewport editor, 26, 29–30
as editor region, 28–29
most editors have, 18
UV Editor, 186–187

Helper bones, 256
Hide and Unhide feature

bones, 260
modeling with, 124
navigating UV Editor, 188
separating UVs, 199

Hierarchies, bone, 255, 260–262
High-resolution simulations, hardware for, 

372
High-speed tracking features, 338
History of Blender, 6–8
Horizontal loop cuts, torso/arms, 152

I
Idea, character preproduction stage, 73
IK (Inverse kinematic) constraint

animating your character, 311–312
character rigging, 264–266

Image Editor
defined, 19
loading reference images side-by-side, 131
placing texture elements using reference 

images, 214
previewing work in Compositor, 355–356
saving modified textures in, 212
saving your image, 215
Texture Paint Workspace, 206, 209
before you begin texture painting, 210
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Image menu, saving your image, 215
Image output, compositing nodes in Cycles, 

360
Image Texture, 242, 243
Images

camera tracking and, 329–330
compositing, in character design, 89
creating new UV test grid, 195
exporting animation as sequence, 366
exporting final render, 365
loading reference, 131
packing your, 215
saving, 215
shooting video for easy tracking, 330–331
texture painting and, 211
texture resolutions, 210
texturing with 2D image-editing software, 

218
UV Editor options, 187

Import, 3D model, 221
In Front option, Display Panel, 267
Info editor, 19
Input nodes, 350–352
Input sockets, nodes, 351–352
Input tab, User Preferences, 38
Inset tool, modeling with, 108–109
Installation, Blender, 13
Instances, 49, 50
Interaction Mode, 3D Viewport header, 29, 52
Interaction modes

modifying objects, 51–52
Texture Pain, 207–209

Interface tab, User Preferences, 38
Interface, UV Editor, 186
Interpolations, keyframe, 318–319
Intersect (Boolean) tool, 102–103
Intersect (Knife) tool, 102–103
Inverse kinematic (IK) constraint

animating your character, 311–312
character rigging, 264–266

IOR (index of refraction) property, materials, 
232

Islands, linked selection for, 97

J
Jacket

chest badge deformation for, 294–295
creating base texture, 214–215

creating zipper, 154
detailing, 156–158
modeling arms for details, 151
packing UVs, 202–203
unwrapping, 200–201

Jaw
rigging, 291–292
skinning eyes and, 292–293

Join Shapes menu, creating shape keys, 296
Join tool, 109–110
Joining areas, 17
Joints, bone, 258

K
Keep Offset, bone hierarchies, 260
Keyboard shortcuts

3D scene navigation, 31–33
Active Tools, 43
Active Tools versus, 35
common animation editor controls, 

319–320
creating objects, 41
Dope Sheet editor, 317
manipulating bones, 260
markers, 335
performing selections, 33–35
pie menus, 24–26
saving and loading .blend file, 64–65
selecting vertices, edges, and faces, 95
Subdivision Surface modifier, 57
Timeline editor, 316–317
tracking features in footage, 336–338
transforms using, 46–47
using manipulators for transforms, 45–46

Keyframes
animating character via, 312–315
choosing only selected curves, 320
marker settings, 336
solving camera motion, 339–340

Keying sets, 314–315
Keymap tab, User Preferences, 38
Knees

adding details to suit, 82
adjusting skeleton to 3D model, 272
creating, 265
modeling boots, 163
modeling legs, 160
painting with blur brush, 286
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practice with bones and IK constraints, 
265–267

requiring complex deformations, 128
Knife (Intersect) tool, 102–103
Knife Project tool, 111
Knife tool (K)

adding details to cap, 170–171
adding wrist to hand, 166–167
blocking basic shape of face, 141–142
defining arms and torso, 154
defining face's shapes, 143–144
modeling base of cap, 169
modeling legs, 160
modeling with, 110

Krita, creating silhouettes, 79

L
Lamp, 3D Viewport editor, 27
Lasso selection, 33, 35
Lattice, 137–139
Launching, final render, 366
Layers

3D texturing vs. 2D image-editing 
software, 222

armature, 274–275
limitations of Texture Paint Mode, 213
materials can be made of several, 230–231
moving bones to armature, 303
protected, 309–310

Legs
animating character's rig, 311–312
animating walk cycle, 321–326
bone hierarchies and, 262
controlling using IK/FK, 264, 269, 

311–312
creating, 265
enabling deforming bones only, 281
modeling, 153, 159–161
modeling boots, 161–163
moving with single control bone, 256
practicing with bones and IK constraints, 

265–267
unwrapping pants, 200
using NLA Editor for animating, 319

Library Linking, reusing character, 307
Licenses

commercial software, 4–5
open-source software, 5

Life of Pi, 3
Light

adding to scene, 62
character postproduction stage, 74
Emission shader converts mesh to, 240
how materials work, 226–227
options, 62
render test scene setup with, 246–248

Lighting your scene
analyzing real footage, 345–346
creating and testing lights, 346–347
overview of, 345
showing/hiding objects in render, 347–348
testing EEVEE and Cycles, 348–349
using Node Editor, 348–349

Lights tab, User Preferences, 38
Limited Dissolve option, Delete tool, 106
Linear interpolation, Graph Editor, 318
Lines, smooth versus steady, 214
Linked duplicates, 49, 50
Linked Flat Faces option, selection, 99
Linked selection, Edit Mode, 97
Linking

animating linked character with proxies, 
310

reusing character in different scenes, 308
working with collections, 308–309

Live Unwrap tool
adjusting UVs, 197
options for, 198
unwrapping hands, 201
in UV Editor, 189
in UV Mapping menu, 188–189

Load Factory Preferences, 39
Load Factory Settings, 39
Load UI option, disabling/enabling, 22
Loading

reference images in 2D image-editing 
software, 218

textures, 223, 242–243
Local Space, configuring drivers, 301
Local View

3D scene navigation, 32
modeling with, 124

Lock Object Modes, 52
Locked to Selection, Movie Clip Editor, 338
Locking, markers, 338
LocRotScale, adding keyframes, 312, 314
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Loft tool, LoopTools, 121
Loop animation, walk cycle, 322
Loop Cut and Slide tool

blocking basic shape of face, 141
blocking basic shapes for torso and arms, 152
defining shape of mouth, 144
modeling boots, 163
modeling legs, 159, 161
modeling with, 112

Loops, 97–98
LoopTools add-ons, 120–121

M
Main menu, UV Editor, 187
Make Edge/Face tool, 113
Manipulators, for transforms, 44–46
MantaFlow, f luid simulation, 372
Maps Baking, 375
Mark Seam tool, UV Mapping, 188–189
Markers

adjusting camera motion, 341–342
anatomy of, 335–336
creating, 336
locking, 338
settings for, 336
solving camera motion, 339–340
testing camera tracking, 343
tracking features in footage, 334, 336–338

Masking, in Movie Clip Editor, 373
Masks, and layers, 230–231
Massachusetts Institute of Technology (MIT) 

license, 5
Master versions, Blender, 9
Match Type, Movie Clip Editor, 336
Material

3D texturing software, 221–222
adding and adjusting, 60–61
channels, 216
compatibility between EEVEE and Cycles, 

58
conditions for texture painting, 211
definition of, 225
introduction to PBR, 215–216
managing, 60

Material option, Texture Slots panel, 212–213
Material Preview viewport shading mode

EEVEE used with, 57
how materials behave, 225

shading character, 243–244
understanding, 58–59
viewing results of, 246

Material Properties tab, Properties Editor, 
60–61, 238–240

Material slots, 236, 238
Material tab, Properties Editor, 225–226, 236
Materials and shaders

accessing nodes for material, 235
applying materials, 225–226
channels, 231–233
differences/compatibility of EEVEE and 

Cycles, 234–235
exercises, 252
how materials work, 226
masks and layers, 230–231
overview of, 225
PBR materials, 226–228
procedural textures, 233–234
running render tests, 246–252
shaders and mix shaders, 229–230
shading your character, 236–246
summary, 252

Materials Properties tab, Properties Editor, 
60–62

Mathematical expression transforms, 47
Menus

animating properties within, 315
Blender UI, 23
transforms using, 47–48
unwrapping, 188

Merge by Distance option, 114
Merge tool, modeling with, 113–114
Mesh

adding Armature modifier to, 283
adding different materials to single, 238
all bones create deform, 280
converting to light with Emission shader, 

240
deforming with deformer bones, 280
f low, 97–98
making skinning process easier, 282–283
modeling tools. See Modeling tools
remesher tools, 374
topology, 127–129
unwrapping, 191–192

Mesh Deform modifier, chest badge, 
294–295
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Metallic material setting, PBR materials, 
227–228

Metallic (Metalness) property, 232, 243
Metallic-Roughness workf low, PBR 

materials, 227–228
Metarig (Rigify skeleton), 257, 276–277
Mirror Mode, eyes, 139
Mirror modifier

adding details to cap, 170–172
adding fingers and wrist, 167–168
assigning, 55
blocking basic shape of face, 141
blocking basic shapes for torso and arms, 

152
detailing backpack and jacket, 158
making skinning process easier, 282
modeling boots, 161–163
modeling legs, 159–161
shaping locks of hair, 172–173
unwrapping mirrored UVs, 192

Mirror painting, creating silhouettes, 79
Mirrored mesh, 109, 192
Mirrored poses, walking animation, 322–323
Mirrored UVs, unwrapping, 192
Mirroring

bones, 291
eye rig, 290
shapes, 298

Mix node, compositing nodes in Cycles, 360
Mix Shader

creating layers, 230–231
defined, 229–230
mixing shaders, 241–242

Mode option, Workspace, 22
Modeling

in character production stage, 73
characters. See Character modeling
shape keys, 295–297

Modeling tools
accessing, 94–95
Auto Merge, 123
Bevel tool, 100–101
Bisect tool, 102
Bridge Edge Loops tool, 104
Connect tool, 104–105
Delete and Dissolve tools, 105–106
Duplicate tool, 106
exercises, 125

Extrude tool, 106–107
F2 add-on, 122
Fill and Grid Fill tool, 108
Global and Local View, 124
Hide and Reveal, 124
Inset tool, 108–109
Intersect (Boolean) tool, 102–103
Intersect (Knife) tool, 102–103
Join tool, 109–110
Knife Project tool, 111
Knife tool, 110
Loop Cut and Slide tool, 112
LoopTools add-ons, 120–121
Make Edge/Face tool, 113
Merge tool, 113–114
Offset Edge Loop tool, 114–115
overview of, 93
Poke tool, 115
Rip and Rip Fill tools, 115–116
sculpting tools, 374
selections. See Selections, making
Separate tool, 116
Shrink/Fatten tool, 116–117
Slide tool, 117
Smooth Vertex tool, 118
Snapping, 124
Solidify tool, 118
Spin tool, 118–119
Split tool, 119
Subdivide tool, 119–120
summary, 125
working with vertices, edges, and faces, 

93–94
X-Ray, 125

Models
making skinning process easier, 282–283
setting up for skinning, 280–281

Modes, Dope Sheet, 317
Modifier tab, Properties Editor, 54
Modifiers

adding, 54–55
adding Armature, 283
adding subdivision surface, 55–57
deforming eyeball using lattice, 137–138
making skinning process easier, 282–283
modeling with, 130
overview of, 54
unwrapping mesh, 192
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Modify modifier, 54
Monkey head (Suzanne), test object in 

Blender, 42
Motion Blur, rendering in Cycles, 358
Mouse, navigating 3D scene, 31–33
Mouth

blocking basic shape of face, 142
creating face controls using bones, 298
creating smooth deformation around, 128, 

129
defining, 145–146
defining on face, 145–146
defining shape of, 143–144
edge f low around, 140
mesh topology for, 127
modeling inside of, 149–150
modeling teeth and tongue, 178–179
packing UVs, 202–203
rigging jaw, 291–292
skinning jaw, 293

Move tool, 43, 44–46
Movie Clip Editor

adjusting camera motion, 341–342
applying tracked motion to camera, 

340–341
camera tracking, 332–333
defined, 19
loading footage, 333–334
masking, object tracking, and video 

stabilization, 373
solving camera motion, 339–340
testing camera tracking, 343
tracking features in footage, 336–338
video tracking features i, 329

Movie Clip node, compositing nodes in 
Cycles, 360–361

Movie productions, Blender used in, 3
Multi-Object editing, packing UVs, 203
Multi-Resolution modifier, Sculpt Mode, 374

N
N-gon

defining eyes, 146
defining face's shapes, 144
Dissolve tool replaces elements with, 105
faces as, 93–94
modeling basic hand shape, 166

Naming
bones and IK constraints, 266
bones automatically, 290
bones before you start rigging, 267
bones for constraint, 263
bones using prefixes, 267–268
character parts when modeling, 139
how vertex groups and bones work, 292
makes skinning process easier, 283
mirrored bones, 291
newly created shape key, 298
objects intuitively, 141
objects using datablocks, 49–51
renaming bones, 259
renaming objects, 49
renaming objects in bulk, 290
renaming reference images in collection, 

134
scene objects, 51

NaN (Not a Number), history of Blender, 6
Navigation

3D scenes in Blender UI, 31–33
common animation editor controls, 320
getting started with nodes, 353
gizmos in 3D Viewport editor, 27
UV Editor, 187–188

Navigation tab, User Preferences, 38
Neck

adding ears, 148–149
adding to jacket, 158–159
modeling shape of face, 141, 143–144
modeling torso and arms, 152, 154
packing UVs, 202–203
unwrapping detail on, 200–201

NeoGeo animation studio, 6
New Image menu, UV test grid, 195
Next Gen, 3
No Textures message, texture painting, 211
Node Editor

basic controls, 352–356
compositing, 349
connecting and manipulating nodes, 

354–355
creating nodes, 353–354
node anatomy, 351–352
overview of, 349
understanding nodes, 349–350
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Node tree, 350–351
Nodes

accessing for material, 235
anatomy of, 351–352
compositing in Cycles, 359–361
connecting and manipulating, 354–355
creating, 353–354
getting started with, 352–353
understanding, 349–350

Noise
procedural texture, 233
removing in renders, 358
rendering to reduce, 250

Non-Linear Animation (NLA) Editor
creating walking animation, 321
defined, 19
overview of, 319
repeating walking animation, 324–325

Nonmetallic material setting, PBR materials, 
227–228

Normal (Bump, Normal Map, Normal 
Bump) property, materials, 232–233

Normal Map property
materials, 232–233
options for calculating, 221
shading character, 243

Normalize option, Graph Editor, 320
Nose

defining, 145–146
defining face's shape, 144
edge f low around, 140
first steps in modeling face, 142
playing with geometry of, 147

Not a Number (NaN), history of Blender, 6
Nth selection, Shortest Path Selection, 96
Numerically precise transforms, 46–47
NumPad

navigating 3D scene, 31–33
setting up reference images, 131
switching between Global/Local View, 124
working with pie menus, 25

O
Object constraints, 263
Object Data Properties tab, Properties Editor, 

50
Object Data tab, Properties Editor, 50, 

132–133

Object Mode
adding details to cap, 171
creating armature in, 258
creating eyeball, 135–136
deforming eyeball using lattices, 137
Join tool used in, 109–110
Lock Object Modes, 52
using interaction modes, 51–52
walking along a path, 325
working with armatures in, 261

Object Properties tab, Properties Editor
adding or subtracting objects from 

collection, 309
creating shadow catcher in Cycles, 357
generating rig, 272
managing datablocks, 50
shading eyeballs in Cycles, 245

Object tab, Properties Editor, 49
Object Types Visibility, 3D Viewport header, 

30
Objects

adding keyframes to, 312–315
adding several materials to single, 

236–237
applying material to multiple, 225
arranging in first scene, 48–49
creating, 41–42
knowing which ones don't need weights, 

281–283
managing datablocks, 49–51
modifying with interaction modes, 51–52
naming scene, 51
renaming, 49
saving to prevent deletion by Blender, 321
selecting, 33–35, 264
showing/hiding in final render, 347–348
tracking in Movie Clip Editor, 373
transforming. See Transforms
viewing, 263

Offset Edge Loop tool, 114–115
Offset option, Shortest Path Selection, 96
Opacity

scene lighting, 346–347
setting up reference images, 132

Open Movies, 6–7, 8
Open-source software (OSS), 4–6, 9
OpenGL, calculating normal maps, 221
Orbit, navigating 3D scene, 31
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Orientation
manipulating bones, 260
rigging eyes, 289

Orientation panel, adjusting camera motion, 
341–342

OSS (Open-source software), 4–6, 9
Outliner

creating collections from, 309
editor, 20
organizing reference images into 

collection, 134
renaming objects, 49
showing/hiding objects in render, 348
Texture Paint Workspace, 206

Output
nodes, 350–352
setting animation, 365–366
sockets, 351–352

Output Properties tab, Properties Editor, 358
Overlays popover, 3D Viewport, 326

P
Pack Islands tool, 203
Packing images, 215
Packing UVs, 202–203
Painting

3D models with 2D texture. See 
Unwrapping and UVs

with random brushes in character design, 
88

software suggestions for, 79
texture. See Texture painting
weight, 284–286, 293

Pan, navigating 3D scene, 31
Panels, Blender UI, 24
Panning, animation editor controls, 319
Pants

modeling legs, 161
packing UVs, 202–203
unwrapping, 200–201

Parallax effect, shooting video, 330
Particle brushes, 3D texturing software, 222
Particle Mode, hair simulation, 371–372
Particles, creating simulations, 371
Path object, 325
Path tracing, Cycles, 233
Pattern orientation, anatomy of markers, 335

Patterns
anatomy of markers, 335
solving camera motion, 340
tracking features in footage, 337

PBR (physically based rendering) materials, 
215–216, 226–228

Pen tablet, 284
Personality

character design details, 82–83
designing character, 76
silhouettes to match character's, 78–79

Perspective
camera tracking, 329–330
shift, 330–331
solving camera motion, 339–340

Perspective/Orthographic switch, 3D scenes, 
32

Photographs, production stages, 73
Physically based rendering (PBR) materials, 

215–216, 226–228
Pie menus, 24–26, 52
Pin button, Material Properties tab, 238
Pin icon, UV Editor, 187
Pipeline, 69
Piracy, commercial software, 5
Pivot Point

3D Viewport header, 30
rotating and scaling around, 45
using 3D cursor as, 36
UV Editor, 187

Placing, 3D cursor, 37
Planning, preproduction stage, 69–70
Poke Faces tool, 115
Poke tool, 115
Pole target, 266
Poly count, of good mesh topology, 128
Poly to poly (poly2poly) modeling, 129
Polygons. See Faces (polygons)
Popovers, Blender UI, 23
Pose Mode

adding constraints, 263
adding custom shapes to bones, 306
adjusting Rigify rig, 277
animating skeletons, 52
armature layers, 274
character rigging workf low, 256
disabling Deform option for bones, 280



397Index

parenting objects to bone, 281
skinning jaw, 293
testing rig in, 268
working with armatures in, 261

Poses
character, 312–315
walking animation, 322–324

Postproduction stage, 70–73, 74
Power property, lights, 62
Precision Mode, 45
Prefixes, naming bones using, 267–268
Preproduction stage, 69–73
Presets, Splash Screen, 15–16
Preview

model, in 3D texturing software, 222
of results, in Compositor, 355–356

Preview panel, Material Properties tab, 238
Previous Frame, marker settings, 336
Principled BSDF shader

compatible with EEVEE and Cycles, 235
as mix of many basic shaders, 241
PBR materials, 227–228
selected when creating material, 229–230
shading character, 243–244

Private investment, Blender development, 10
Process nodes, 350–352
Production stage, 70–74
Project from View tool, UV Mapping, 190
Project overview

character-creation plan, 73–74
defining stages, 70–73
exercises, 74
summary, 74
three stages of project, 69–70

Projected from View option, proportional 
editing, 97

Properties
animating within menus, 315
of material channels, 231–233
node, 351–352

Properties Editor
adding or subtracting objects from 

collection, 309
Armature Properties tab, 274
Armature tab, 267
basic material setup in, 235
Bone Properties tab, 259

defined, 20
managing datablocks, 50
Material tab, 225–226, 236
Modifier tab, 54
Object Data Properties tab, 50
Object Data tab, 132
Object Properties tab. See Object 

Properties tab, Properties Editor
Output Properties tab, 358
panels, 24
Protected Layers, 309–310
renaming objects, 49
Render Properties tab, 63–64, 248
Render tab, 57–58
shader selector for material in, 229
Texture Paint interaction mode, 208
Texture Paint Workspace, 206
Tool Properties tab, 258–259
Vertex Groups panel, 279
Workspace options, 22–23
World tab, 247–248

Proportional Editing and Snapping tools, UV 
Editor, 187

Proportional Editing tool
3D Viewport header, 30
adjusting UVs, 198
blocking basic shape of face, 141
detailing backpack and jacket, 157
modeling boots, 163
selections in Edit Mode, 96–97

Protected Layers, 309–310
Proxies, animating linked character with, 

310
Python Console editor, 19
Python scripting, 269, 376

Q
Quads (four-sided faces)

defined, 93
good mesh topology using, 128
modeling boots, 163

R
RAM, caching footage and, 334
Ray Visibility subpanel, Visibility panel, 245
Real-time cloth simulation, 372
Real-time preview rendering, 59
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Real-time render engine. See EEVEE (real-
time render engine)

Red Riding Hood, 3
Reference images

fitting 3D models to character design, 
86–88

loading for modeling, 131–134
placing texture elements with, 214
proper alignment of, 133

Refine option
configuring camera settings, 339
solving camera motion, 339–340

Ref lections, of materials, 226–227
Refraction

in EEVEE versus Cycles, 233
reducing effects of, 244
shading eyeballs in Cycles, 245
shading eyeballs in EEVEE, 244

Refraction shader, 240
Regenerating Rigify rig, 276–277
Regions, 3D Viewport editor, 27–29
Relax tool, LoopTools, 121
Release Confirms option, Transforms, 46
Remesh, 130
Remesher tools, 374
Renaming objects, 49
Render

character postproduction stage, 74
composite before, 349
creating Shadow Catcher in Cycles, 357
creating Shadow Catcher in EEVEE, 

361–364
in Cycles, 250–252
defined, 63
in EEVEE, 248–249
enabling GPU in Cycles, 64
exercises, 366
exporting final, 365–366
final render in Cycles, 361
final render in EEVEE, 365
launching and saving, 65–66
launching final, 366
overview of, 63–64
real-time preview, 59
saving and loading .blend file, 64–65
scene in Cycles, 357–359
scene in EEVEE, 364
showing/hiding objects in final, 347–348

summary, 366
test scene setup, 246–248

Render Animation, final render, 366
Render Image, final render, 366
Render Layers node, Cycles, 360
Render Properties tab, Properties Editor

rendering in Cycles, 250, 357–359
rendering in EEVEE, 248
rendering in EEVEE and Cycles, 63–64
with Simplify, 321

Render tab, Properties Editor, 57–58, 375
Render tests

adding lights and environment, 246–248
in Cycles, 250–252
in EEVEE, 248–249
overview of, 246

Rendered viewport shading mode
displays result similar to final render, 

58–59
enabling for scene lighting, 347
previewing light effects in EEVEE, 62
real-time preview rendering, 59
rendering in Cycles, 358
seeing how materials behave, 225
shading eyeballs in Cycles, 245
testing EEVEE and Cycles, 348–349

Reset option, UV Mapping, 190
Resetting, User Preferences, 39
Resizing areas, 16
Resolution

image textures, 210
improving render results for EEVEE, 248
running render tests, 247

Resolution, video
FPS and, 334
in Graph Editor, 318–319
shooting for easy tracking, 331
in Timeline editor, 316
for walking animation, 323

Resources
Blender community forums/websites, 11
Blender Foundation and development, 10
testing development versions of Blender, 9

Restriction toggles, 134, 348
Retopology, 374, 375
Retouches, f inal, 306–307
Revert to Saved Preferences, 39
RGB Curves node, 351
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Rig. See Rigify rig
Rigging. See Character rigging
Rigid body simulation, 372
Rigify Buttons panel, Properties Editor, 276
Rigify rig

adding custom buttons, 303–305
adding details to, 179
adjusting 3D models, 270–272
adjustments to, 276–277
animating using character's, 311–312
armature layers, 274–275
armatures. See Armatures
bone groups, 273–274
Buttons panel, 273
character design, 80, 82–83
checking deformations, 287
creating skeleton, 269–270
enabling, 267
final retouches, 306–307
forward and inverse kinematics 

automation, 264
generating rig, 257, 272–273
introducing, 268–269
modeling cap, 82–83, 168–172
modeling jacket, 154, 156–158
organizing bones, 273–274
posing character, 312–315
Python scripts for, 269
rigging process, 256–257
rigging your character. See Character 

rigging
shading character, 243
summary of process, 268
testing color schemes, 83–84
tips before you start, 267–268
understanding, 275–276

Rigify skeleton (metarig), 257, 276–277
Rings, selecting, 97–98
Rip and Rip Fill tools, 115–116
Roosendaal, Ton, 4, 6, 9
Root, rig, 262
Rotate tool, 43, 44–46
Rotation

animating character's rig, 311
side effects of mirroring bones, 291

Rough material setting, PBR materials, 
227–228

Roughness (Glossiness) property, 232, 243

Roughness, of materials, 226–227
Rules, PBR materials, 226

S
Sampling

rendering in Cycles, 357–358
rendering in EEVEE, 248

Sampling panel, Cycles, 250
Save & Load tab, User Preferences, 38
Saving

.blend file, 64–65
image, 215
modified textures, 212
objects to prevent deletion by Blender, 321
rendered frames, 365
renders, 65–66
User Preferences, 39
UV exported as image, 218
Workspaces, 22

Scale tool, 43, 44–46
Screen Space Ref lections, EEVEE, 63, 244, 

248
Script, adjusting Rigify, 303–305
Scroll wheel, UI, 21
Sculpt and Retopology modeling, 129–130
Sculpt Mode, 3D Viewport, 374
Sculpt tools, adjusting UVs, 198
Sculpting, as creative way of modeling, 374
Seams, 190–191, 193–194
Search area, markers, 335
Search menu, creating objects, 41
Search, modeling tools, 95
Select Boundary Loop tool, 99
Select Loop Inner-Region tool, 99
Select, material slots, 237
Select menu, 3D Viewport header, 98–100
Select Similar options, 99
Select Split tool, 199
Selection mode, UV Editor, 186
Selection, object, 33–35
Selections, making

border selection, 98
Checker Deselect tool, 100
grow and shrink selection, 98
Linked Flat Faces option, 99
linked selection, 97
loops and rings, 97–98
other selection methods, 100
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proportional editing, 96–97
Select Boundary Loop tool, 99
Select Loop Inner-Region tool, 99
Select Similar options, 99
Shortest Path Selection, 95–96
vertices, edges, and faces, 94

Separate tool, 116, 158
Separating UVs, 199
Settings panel, Material Properties, 240, 244
Setup Tracking Scene button, camera 

motion, 342
Shade Smooth, 53, 135–136
Shader Editor

accessing nodes, 235
defined, 19
using nodes, 352

Shaders
materials made up of, 225
and Mix shaders, 229–230
mixing and adding, 241–242
most-used, 240–241
overview of, 240
Surface Shaders options, 31–33

Shading
adding materials, 225
Viewport, 58–60

Shading your character
adding several materials to object, 236–238
basic steps for, 243–244
loading textures, 242–243
Material Properties tab, 238–240
mixing and adding shaders, 241–242
most-used shaders, 240–241
overview of, 236
production stage, 73
shading character, 243–246
shading eyeballs in Cycles, 245
shading eyeballs in EEVEE, 244

Shadow catcher
creating in Cycles, 357
creating in EEVEE, 361–364

Shadows
analyzing real footage before adding lights, 

345–346
creating and testing scene lighting, 346–347
more accurate in Cycles than EEVEE, 251

Shadows panel, 248

Shape Key Editor, Dope Sheet, 317
Shape keys

configuring drivers, 300–301
creating facial rig, 288
mirroring shapes, 298
modeling, 295–297

Shapes
blocking basic face, 140–142
creating custom, 305–306
creating rig with Rigify by adjusting 

skeleton, 268
defining face's, 142–144
good mesh topology follows the, 129
mirroring, 298

Shield button, datablocks, 51
Shoes. See Boots
Shortest Path tool, 95–96, 194
Shoulders

adding details to suit, 82
defining arms and torso, 154–155
detailing backpack and jacket, 157
modeling torso and arms, 151–154
requiring complex deformations, 128
unwrapping rest of character, 201

Show/Hide
objects in render, 347–348
unused sockets, 354

Show Wire option, weight painting, 286
Shrink/Fatten tool, modeling with, 116–117
Shrink selection, 98
Shrinkwrap modifier, skinning process, 282
Side parameter, setting up reference images, 

133
Sidebar, 3D Viewport

accessing bone properties, 258
animating character's rig, 311
as editor region, 28
LoopTools in, 120–121
posing character with, 312–315
tabs, 27
Threshold option, Auto Merge, 123
using menus for transforms in, 47–48
X-Axis Mirror option, 258

Sidebar, Movie Clip Editor
configuring camera settings, 339
loading footage, 332
marker settings, 336



401Index

Sidebars, panels, 24
Silhouettes, 78–79, 88
Simplify option, animating with, 321
Simulate modifier, 54
Simulations, types of, 371–372
Single bone, 264–267
Single Image, Texture Slots panel, 212–213
Sintel (2010), 6
Skeleton panel, 274–275
Skeletons. See also Character rigging

3D cursor poses characters without, 157
adding in character production, 73
adjusting to 3D model, 270, 271–272
animating in Pose Mode, 52
armatures in Blender as. See Armatures
creating, 269–270
generating rig, 272–273
made of datablocks, 49
not needed for posing with 3D cursor, 36
using Skin modifier for thickness, 88–89

Skin modifier, character design, 88–89
Skinning

adding armature modifier, 283–284
chest badge deformation, 294–295
control face shapes with drivers, 299–303
creating face controls, 298–299
creating facial rig, 288
defined, 278
defining weights, 284–287
enabling deformer bones only, 281
eyes and jaw, 292–294
knowing which objects don't need weights, 

281–283
mirroring bones, 291
mirroring eye rig, 290
mirroring shapes, 298
modeling shape keys, 295–297
naming bones automatically, 290
organizing facial rig, 303–305
rigging eyes, 288–289
rigging jaw, 291–292
setting up model for, 280–281
vertex groups, 278–279
vertex weights and, 278

Skip option, Shortest Path Selection, 96
Sky Texture, render test scene, 247
Slide tool, 117

Smart UV Project tool, 190
Smooth interpolation, Graph Editor, 318
Smooth lines, placing texture elements, 214
Smooth material setting, PBR materials, 

227–228
Smooth surfaces, 53
Smooth Vertices tool

adding wrist to hand, 166–167
blocking basic shape of face, 141
modeling basic hand shape, 164
modeling with, 118

Snap menu, 3D cursor, 36
Snap Mode, 45
Snap tools, adjusting UVs, 198
Snapping, 30, 124
Snapping tool, 123, 375
Sockets, node, 351–352
Soft body simulation, 372
Software, texturing

2D image-editing, 217–221
3D, 221–222
overview of, 216

Solid viewport shading mode, 58–59, 
237–238, 286

Solidify modifier, skinning process, 282
Solidify tool

detailing backpack and jacket, 157
modeling cap, 170–172
modeling eyebrows, 176–177
shaping locks of hair, 173
working with, 118

Solve Camera Motion button, 339–340
Solve tab, camera motion, 339–340, 341–342
Source code, 5
Space selector, configuring drivers, 301
Space tool, 121
Specular-Glossiness workf low, PBR 

materials, 227–228
Specular property, materials, 232
Speed option, monitoring tracking, 338
Sphere Projection tool, UV mapping, 190
Spider-Man 2, 3
Spin tool, 118–119
Splash Screen, Blender UI, 15–16
Split tool, 119
Splitting areas, 17
Spring (2019), 6–8
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Squares, in good mesh topology, 128
Stabilization, camera, 331
Stabilize Stroke option, drawing, 214
Startup file, creating own, 39–40
Static features, shooting video, 331–332
Status Bar, 16, 211
Steady lines, drawing, 214
Sticky Selection mode, UVs, 186, 199
Stitch tool, 199
Stroke options, drawing, 214
Style, character design, 77
Subdivide tool, modeling, 119–120, 164
Subdivision Surface modifier

adding details to cap, 170–172
adding ears, 147–148
adding fingers to hand, 166–167
adding neck to jacket, 159
adding to your object, 55–56
Armature modifier and performance of, 

283
creating eyeball, 135–136
keyboard shortcut, 57
modeling base of cap, 168–169
modeling eyebrows, 176
poly to poly modeling, 129
rendering animation with Simplify, 321
smoothing shapes with, 144
texturing with 2D image-editing software, 

218
viewing geometry when modeling, 148

Substance Painter (3D texturing software), 
221

Subtracting objects from selection, 33
Sun light

creating and testing scene lighting, 347
rendering in EEVEE, 248

Surface Deform modifier, chest badge, 
294–295

Surface Shaders, 60–61, 239
Surfaces, f lat or smooth, 53
Swapping areas, 17–18
System tab, User Preferences, 38

T
T pose, modeling arms in, 151
Target bone, 262, 263
Tears of Steel (2012), 6–7

Teeth
building inside of mouth for, 149
modeling, 178
using parenting to make, 293

Tension, good mesh topology and, 128
Test grid, UVs, 194–196, 198
Test object, 42
Testing

camera tracking, 343
EEVEE and Cycles for lighting scene, 

348–349
lights for your scene, 346–347
rig, in Pose Mode, 268
skinning process, 293

Texel density, 191
Text Editor, 19, 303–305
Text info, 3D Viewport editor, 26–27
Texture

character production stage, 73
definition of, 205
displaying UV text grid in model, 195–196
Maps Baking bakes lighting into, 375
modeling boots, 163
packing UVs, 202–203
painting boots, 163
procedural, 233–234
UV placement and seams, 190–191

Texture Node Editor, 19, 352
Texture Paint interaction mode, 207–209, 

210
Texture Paint Mode, 206–209, 210–213, 284
Texture Paint Workspace, 206–207
Texture painting

with 3D texturing software, 221–222
conditions for, 210–211
creating base texture, 214–215
elements of texture, 215–216
exercises, 224
limitations of Texture Paint Mode, 213
main workf lows for, 205–206
one object at a time, 209
with other software, 216–221
overview of, 205
seeing painted character, 223
summary, 223–224
Texture Paint interaction mode, 207–209
Texture Paint Workspace, 206–207
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texture slots, 212–213
before you begin, 209–210

Texture Slots panel, 211, 212–213, 215
Themes tab, User Preferences, 38
“Think twice, work half,” as preproduction 

stage, 70
Threshold option, Auto Merge, 123
Timeline editor

animation with, 316–317
creating walking animation, 323
defined, 19

Timeline, Movie Clip Editor, 333–334
Tongue, modeling, 178
Tool Properties tab, Properties Editor, 

258–259
Tool Settings

3D Viewport editor, 26
3D Viewport header, 29
Weight Paint Mode, 286

Toolbar
3D Viewport editor, 27
accessing modeling tools, 95
as editor region, 28
Movie Clip Editor, 332, 336

Tools
modeling. See Modeling tools
UV Mapping, 188–190

Top Bar
defined, 16
in Weight Paint Mode, 284
Workspaces, 21

Topology
defining muscles in arms and torso, 154
mesh, 127–129
retopology as recreating shape with new, 

375
studying face, 139–140

Torso and arms, modeling
adding neck to jacket, 159
basic shapes, 152–154
blocking basic shapes, 152
defining, 154–155
detailing backpack and jacket, 156–158
finishing belt, 158–159
overview of, 150–151

Track Backward features, 337
Track Forward features, 337

Track To constraint, 263, 288–289
Tracked frames, anatomy of markers, 336
Tracked markers, camera, 329–330
Tracking camera motion, loading footage, 

333–334
Transform Orientation, 3D Viewport header, 

29, 45
Transform panel, 47–48
Transform property, 301
Transform tool, 43
Transforms

animating rig, 311
arranging objects in scene, 48–49
defined, 30
numerically precise, 46–47
Release Confirms option, 46
simplifies skinning process, 283
using Active Tools, 42–43
using keyboard shortcuts (advanced), 46–47
using manipulators, 44–45
using menus, 47–48

Transmission (refraction) property, materials, 
232

Transparency
rendering background in Cycles, 358–359
rendering in Cycles, 250
rendering in EEVEE, 248
setting up reference images, 132

Transparent BSDF shader, 240
Triangles, faces as, 93–94

U
UI. See User interface (UI)
Unwrap tool, 188
Unwrapping and UVs

exercises, 204
how they work, 183–184
introduction, 183
packing UVs after, 202–203
separating and connecting UVs, 199
summary, 203
texturing after unwrapping, 205–206
texturing before unwrapping, 205
unwrapping rest of character, 200–201
before you begin painting texture, 209–210

Unwrapping and UVs, unwrapping
accessing unwrapping menus, 188
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considerations before unwrapping, 191–193
defining seams, 190–191
navigating UV Editor, 187–188
overview of, 184–185
using UV Editor, 185–187
UV mapping tools, 188–190

Unwrapping and UVs, UVs
adjusting UVs, 198–199
creating and displaying UV test grid, 

194–196
marking seams, 193–194
overview of, 193
reviewing finished face's UVs, 200
separating and connecting UVs, 199–200
unwrapping character's face, 196–197
using Live Unwrap, 197–198

Unwrapping, character production stage, 73
Update Dependencies, configuring drivers, 

300
Use Nodes option, Compositor, 352–353
User interface (UI)

3D cursor, 35–37
3D viewport, 26–30
areas of, 16–18
creating own startup file, 39–40
default editors, 16
downloading and installing Blender, 13
editor types, 18–21
exercises, 40
menus and popovers, 23
navigating 3D scene, 31–33
panels, 24
pie menus, 24–26
recommended hardware, 13–14
selecting objects, 33–35
Splash Screen, 15–16
Status Bar, 16
summary, 40
Top Bar, 16
User Preferences, 37–39
viewing hidden menu or header in, 21
workspaces, 21–23

User Preferences
disabling Splash Screen in, 16
enabling F2 add-on, 122
overview of, 37

resetting, 39
saving, 39
switching Walk Mode/Fly Mode in, 33
tabs, 21, 38

UV Editor
defined, 19
Live Unwrap in, 197–198
overview of, 185–189

UV menu, 187, 188
UV Sphere, 135–136, 168–169
UV Sync Selection mode, 186, 199
UV test grid, 194–196, 210
UVs. See also Unwrapping and UVs

conditions for texture painting, 211
defined, 183
texturing in 2D image-editing software, 

217–218

V
Values, weight, 287
Variables, drivers, 300
Vector imaging software, character design, 88
Vector setting

loading textures, 242
shading character, 243

Vertex groups
adding new bones to deformation, 

292–293
skinning, 278–279
working in Weight Paint Mode, 284–285

Vertex Groups menu, 293
Vertex Groups panel, 279, 287
Vertex menu, 141
Vertex weights, 278–279
Vertex Weights panel, 287
Vertices

defined, 93
joining with Connect tool, 104–105
keep adjusting when adding, 164
selecting, 94
working with, 93–95

Video
editing, 374
editing tools, 374
export animation as, 366
recording, 74
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shooting for easy tracking, 330–331
stabilization, in Movie Clip Editor, 374

Video Sequence Editor, 19, 374
View Layer Properties tab, Property Editor, 

358
View menu, navigating from, 33
View Selected, 3D scenes, 31
Viewer node, 355, 360
Viewport Display, 237–238, 240
Viewport Gizmos, 30, 44
Viewport Overlays, 30
Viewport shading, 30, 58–60
Viewport tab, User Preferences, 38
Visibility panel, 245
Visual-effects f ilm, 72
Volume Absorption shader, 240
Volume options, Material Properties tab, 239
Volume Scatter shader, 240
Volumetrics, 31–33

W
Walk-Cycle action, NLA Editor, 324–325
Walk cycle, animating

along a path, 325–326
creating action, 321
creating poses, 322–324
Non-Linear Animation Editor repeats, 319
repeating, 324–325
tips, 321
using character's rig, 311

Walk Mode, 32–33, 63
Warcraft, 3
Weight

adding Armature modifier with automatic, 
283–284

deformations and characters,' 287–288
knowing what objects do not need, 

281–283
making skinning process easier, 282–283
painting, 284–286
skinning eyes and jaw, 293
values, 287

vertex, 278
vertex groups and, 278–279

Weight Paint interaction mode, 279
Weight Paint Mode, 284–286, 293
Weight Paints visualization, 286
What Every BODY Is Saying: An Ex-FBI 

Agent’s Guide to Speed-Reading People 
(Navarro and Karlins), 76

Whole Character Keying Set, 314, 323
Wireframe viewport shading mode, 58–59, 

277
Workbench Engine, viewport shading, 58
Workbench, rendering images, 57–58
Workf lows

character rigging, 256–257
defined, 69
PBR, 227–228
using textures on 3D models, 205–206

Workspaces, 21–23
World light, scene lighting, 347
World Properties tab, Properties Editor, 347
World tab, Properties Editor, 247–248
Wrist, adding to hand, 166–168

X
X-axis, 290
X-Axis Mirror option, 258–259
X-Mirror option, Tool Settings, 286
X-Ray

3D Viewport header, 30
modeling with, 125
weight painting with, 286

Y
Yo Frankie! (2008) video game, 6

Z
Zoom

animation editor controls, 319
avoid when shooting video for easy 

tracking, 331
navigating 3D scene, 31–33
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